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INTRODUCTION 
 

AutoCAD software is used by draftsmen and other professionals for preparing the layouts and designs in 

architecture industry. It is also used in other industries for designing the layout of the products and their 

components in three dimensions. 

 

The National Vocational & Technical Training Commission (NAVTTC) has developed a national 

qualification entitled, “National Vocational Certificate Level-4 in Information Technology (CAD-3D Studio 

MAX)”. Relevant industry and employers were consulted in the design and validation processes in order to 

come up with a national qualification that fulfills the requirements of the sector in general and the occupation 

in particular. 

 

This Teaching and Learning Material (TLM) is developed based on competency standards and curriculum 

of the AutoCAD national qualification. It includes three learning modules which are as under: 

 

Module 6:  Develop 3D Models using 3D Studio MAX 

 
 

This TLM provides support for more effective training and productive learning. The learning module contains 

learning outcomes and information regarding learning elements in the form of knowledge, skills and 

attitudes. At the end of learning module are Frequently Asked Questions (FAQs) and Test yourself which 

will help learners in self-assessment before proceeding to modular or final assessment. 
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Module 6: 
Develop 3D Model using 3D studio Max  
 
Objective: 

This module is designed to provide a comprehensive 3D Max 

modeling and rendering solution to interior designer architects and 

engineering (electrical, mechanical, civil) you can cover the interface 

and proper workflow for setting up 3ds max project with cameras 

lighting and rendering. You can handle more complex scenarios and 

techniques which are found in 3ds max. 
 
Learning units: 

After Completion of this learning module, you will be able to: 
 

· Create object using geometry and shapes 

· Modify objects 

· Apply material and textures to object 

· Render 3D model   
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Learning Unit 1:  

Create objects using geometry and shapes 
 

Objective: 

In this unit we demonstrate 3D Max interface and use different types 

of tool bar like Quick Access tool bar, main tool bar, ribbon tool Bar 

etc. 

Also explain that how to merge and import the link file DWG, FBX and 

RVT into 3D max. 
 
 

Learning Outcomes:  

After completion of this Learning Unit you will be able to: 

 

v Create/import/link/fetch/merge 2D Drawing to make 3D object 

according to given specification. 

v Use geometry & shapes to make 3D objects according to given 

specification. 
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1. Create objects using geometry and shapes 

 

Let's proceed Creating simple geometric shapes. Take one of them, Ellipse Tool (L). Release the button when 

we see the desired shape of the ellipse. If you need to create a circle or other shape with the same height and 

width. 

 

1.1. Create/import/link/fetch/merge 2D Drawing make 3D Object according to given 
Specification  

 

Autodesk 3ds Max, formerly 3D Studio and 3D Studio Max, is a professional 3D computer graphics 

program for making 3D animations, models, games and images. It is developed and produced 

by Autodesk Media and Entertainment. It has modeling capabilities and a flexible plugin architecture and 

can be used on the Microsoft Windows platform. It is frequently used by video game developers, many 

TV commercial studios and architectural visualization studios. It is also used for movie effects and movie 

pre-visualization. For its modeling and animation tools, the latest version of 3ds Max also 

features shader dynamic simulation, particle systems, radiosity, normal map creation and 

rendering, global illumination, a customizable user interface. 

 

1.1.1. Demonstrate 3D Max interface 

One of the most important aspect of using 3ds Max is its versatility. Many program functions are 

available from multiple interface elements. For example, you can open Track View for animation 

control from the Main toolbar as well as the Graph Editors menu, but the easiest way to get to a 

specific object's track in Track View is to right-click the object and then choose Track View is 

Selected from the Quad menu. 
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1.1.1.1. Quick Access Tool Bar  

The Quick Access toolbar provides some of the most commonly used file-management 

commands, as well as new, open save, undo/redo and import. 

 

3ds Max window > Quick Access toolbar 

 
 

 New Scene  

 

Click to begin a New file. Its short key is  

CTRL+ N 

 

 Open File  

 

Click to Open a saved file. its short key is 

CTRL+N 

 

 Save File  

 

Click to save the currently open file. its short key is  

CTRL+S 
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 Undo Scene Operation  

 

Click to undo the previous operation. Click the down-arrow to display an ordered list of 

previous operations, so you can choose the point from which to undo your work. See 

Undo. Its short key is  

CTRL+Z 

 

 

 Redo Scene Operation  

Click to redo the previous operation. Click the down-arrow to display an ordered list of 

previous operations, so you can choose the point from which to redo your work. See 

Redo. Its short key is CTRL+Y 

 

Enhanced Menu  

The optional Enhanced menu system features improved organization of the default 

layout, configurable display, detailed tooltips that link to relevant help topics, drag-and-

drop menu categories, and the ability to search for menu commands from the keyboard. 

To access the Enhanced menus, open the Workspaces drop-down list on the Quick 

Access toolbar and choose Default with Enhanced Menus. 

 
    

 
 

 

1.1.1.2. Main Tool Bar  

 

The main toolbar provides quick access to tools and dialogs for many of the most 

common tasks in 3ds Max. 

 

 
 

 
 

Tip: If the main toolbar is wider than the 3ds Max window (or even than your computer 

screen), you can pan it by dragging a gray area of the toolbar, such as below the drop-

down lists. 
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 Select and Link 

 

 

 
 

 

 

 Unlink Selection 

 

 

 
 

 

 

 Bind to Space Warp 

 

 

 

 

 

Selection Filter List 

 

 

 

 
 

 

 

Select Object 

 

 

 
 

 

 

Select by Name 

 

Selection Region Flyout 
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Window/Crossing Selection Toggle 

 

 

 
 

 

Select and Move 

 

 

 
 

 

Select and Rotate 

 
 

 

 

Select and Scale 

 

Note: Right-clicking the Move, Rotate, or Scale button opens the Transform Type-In 

dialog. 

 

 

Select and Place flyout 

 

 

Note: Right-clicking the Select And Place or Select And Rotate button opens the 

Placement Settings dialog, also described in Select and Place. 

 

 

Select and Place flyout Reference Coordinate 

System 

 

 

 

Use Center Flyout 
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Select and Manipulate 

 

 

 

 

 

 

 Keyboard Shortcut Override Toggle 

 

 

 
 

2D Snap, 2.5D Snap, 3D Snap 

 
Angle Snap Toggle 

 
Percent Snap Toggle 

 

Spinner Snap Toggle 

 

 

Edit Named Selection Sets 

 

 

 

 
 

 

Named Selection Sets 

 

 

Mirror 
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Align Flyout 

 

 

 

Toggle Scene Explorer 

 

 

Toggle Layer Explorer 

 

 

 

Toggle Ribbon 

 

 

Curve Editor (Open) 

 

 

Schematic View (Open) 

 

 

Material Editor flyout 

 

 
Render Setup 
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Rendered Frame Window 

 

   

 

Render fly out: 

 

Render Production 

 

 

Render Iterative 

 

 

Active Shade 

 

 

Render in Autodesk A360 

 

 

Open Autodesk A360 Gallery: Opens the Web page 

that showcases A360 Cloud renderings. 

 

 

1.1.1.3. Ribbon Tool Bar 

The ribbon interface takes the form of a highly customizable, context-sensitive toolbar 

containing these tabs: 

 

· Modeling 

· Freeform 

· Selection 

· Object Paint and 

· Populate.  

Each tab comprises several panels and tools whose availability can depend on the 

context. 
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· The Ribbon Interface 

The modeling ribbon takes the form of a toolbar that can float or dock in a horizontal or 

vertical configuration. The toolbar contains four tabs.  

 

· Modeling  

The Graphite Modeling Tools tab contains the tools you use most often for polygon 

modeling, organized into separate panels for easy, convenient access.  

 

 
 

· Freeform Tab 

The Freeform tab contains tools for creating and modifying polygon geometry by 

"painting" in the viewports. Also, the defaults panel provides for saving and loading brush 

settings.  

 

 
 

· Selection Tab 

The selection tab of the modeling ribbon provides a variety of specialized tools for making 

sub-object selections. For example, you can select concave or convex areas, sub-objects 

that face the viewpoint, or point in a certain direction, and more.  

 

 
 

· Object Paint Tab 

The Object Paint tool enables you to paint objects freehand anywhere in the scene or 

onto specific object surfaces. You can also “fill” selected edges automatically with paint 

objects. You can paint with multiple objects in a specific order or at random and change 

the scale as you paint. Applications include applying regular surface features such as 

rivets, plants, columns, and even populating a scene with characters.  
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· Populate Tab 

The Populate toolset consists of these basic components: 

 

i. Flow:  

A pathway for walkers that resembles a sidewalk or hallway. A flow consists of one or 

more connected straight-line flow segments that you create by clicking and moving the 

mouse in a viewport. When a flow is correctly formed, with permissible angles between 

segments and of inclines, parallel lines indicating pedestrian paths appear along its 

length. At the endpoints of each line are arrows indicating its flow direction. Also, red and 

blue marks on flows indicate starting points and walking directions of female and male 

people, respectively. 

You can edit existing flows by moving segments and their endpoints, known as flow 

points. You can also subdivide a flow to add complexity to the path. You can also create 

inclines and declines, also known as ramps, which have their own markings. 

Where two flows intersect, a green cross-shaped arrow appears. This indicates that 

walkers on one flow can change direction at random to move to the intersecting flow. 

Each flow has two portals: Portal 1 and Portal 2. The portal is the direction from which 

pedestrians appear on the flow. 

 

ii. Idle Area: 

A region separates from the flows where people congregate, such as a park or traffic 

island. Settings include density and how the people form groups of interacting characters. 

Idle areas are always distinct from flows; Populate does not support the passage of 

people between the two. 

iii. Seat: 

A box-shaped object on which one person sits. You can place seats on idle areas or 

anywhere else in the scene. People sitting on seats can interact with people sitting on 

nearby seats, or they can behave as if they are alone. 
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The virtual humans in the Populate simulation. You can adjust their appearance by 

setting a skin type, from stick figure to textured skin, by regenerating their look, swapping 

their appearance, and by switching between resolutions. 

 

· Customizing the Ribbon 

The Customize Ribbon dialog offers a wealth of tools for editing the modeling ribbon. You 

can use the mouse and keyboard to rearrange existing controls, rename them, and 

change their icons. More important, you can add controls based on almost any tool in 3ds 

Max, or new tools based on custom scripts. 

 

1.1.1.4. Scene Explorers 

Scene Explorer provides a modeless dialog for viewing, sorting, filtering, and selecting 

objects in 3ds Max, as well as additional functionality for renaming, deleting, hiding, and 

freezing objects, creating and modifying object hierarchies, and editing object properties 

masse. 

 

 

 

 
 

  Scene Explorer provides a modeless dialog for  

 

v. Viewing 

vi. Sorting 

vii. Filtering 

viii. Selecting objects in 3ds Max and  

ix.  Renaming 

x. Deleting 

xi. Hiding 

xii. Freezing objects 

xiii. Creating and modifying object hierarchies  

xiv.  Editing object properties masse. 

iv. People: 
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· How to active scene explorer 

Standard menu: Tools Menu > Scene Explorer 

 

Standard menu: Tools menu > All Global Explorers or Local Scene Explorers > Choose a 

saved Explorer. 

Main Toolbar > Toggle Scene Explorer 

Enhanced menu: Scene menu > Manage Scene Content > Scene Explorer 

 

The Scene explorer interface consists of a menu bar, toolbars, and a table view of 

objects in the scene, with a row for each object and a column for each displayed object 

property.  

 

The default layout in 3ds Max displays only object names and the frozen property. You 

can customize the layout to show additional properties. You can create local scene 

explorer setups that save and load with the current scene, and global ones that are 

available in all scenes. 

 

· Scene Explorer Modes 
Scene Explorer can switch between two different sorting modes using the buttons on the 

Selection toolbar: 

 

 
 
 
 
 
 
 
 
 
 
 

 this icon sets Scene Explorer to Sort by Layer mode, providing drag-and-drop 

functionality for editing layers. Additional features are covered in this section and in the 

To Work with Layer Explorer section. 

 

 this icon sets Scene Explorer to Sort by Hierarchy mode, providing drag-and-

drop functionality for editing hierarchies. Additional features are covered in this section. 

 

· Workspace Scene Explorers 
Each workspace in 3ds Max includes a different Scene Explorer, with the same name as 

its workspace, docked to the left of the viewports. For specific information about its 

operation, see the Workspace Scene Explorers section of the Workspaces topic. 
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Workspace Scene Explorer (red outline) docked in 3ds Max interface 

 

 

· Multiple Scene Explorers 
For many workflows, the single workspace Explorer docked on the left side of the 

interface will suffice. However, you can open as many unique explorers as you like, 

Including: 

 

i. Layer Explorer 

ii. Revit Explorer and so on to make a copy of a unique 

explorer, use the methods described in the topic To Work 

with Local and Global Scene Explorers 

 

 

· Scene Explorer Features 
Following are further noteworthy features of Scene Explorer: 

 

Customize the dialog by setting any configuration of columns, hidden and displayed 

categories (via the left-hand toolbar), and so on. 

 

Selection is automatically synchronized between Scene Explorer and the scene: Select 

an object in the viewport and it automatically highlights in Scene Explorer, and vice-

versa. 

 

Use local Scene Explorers that are specific to the current scene, and global Scene 

Explorers, which are available in all scenes. 

TIP: You can reopen 
the most recently 
closed Scene 
Explorer instance 
later in the same 
session with the 
keyboard 
shortcut Alt+Ctrl+O  
(the letter O). 
 

Remember 
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Switch the sorting and listing mode between hierarchy and layer. 

 

· Nest layers to any depth. 

Dock the dialog right or left by dragging and dropping or by right-clicking the title bar and 

choosing the Dock location. 

Toggle object and layer visibility by clicking the light bulb icon. In the following illustration, 

hiding the Plants layer also makes all of its children (Foliage003, etc.) invisible. 

 

 
 

Note: The light bulb icon has no connection with scene lighting; it merely indicates 

whether an object or layer is visible (yellow) or not (gray). 

View group members in Scene Explorer (Sort by Hierarchy mode only) without having to 

open the group.  

 

· Scene Explorer Variants 
Several specialized versions of Scene Explorer are available in different areas of 3ds 

Max. They provide column and toolbar setups appropriate for working in specific areas 

of 3ds Max. These include: 

 

i. Layer Explorer 

ii. Container Explorer 

iii. Mass FX Explorer 

iv. Material Explorer 

Several additional custom global Scene Explorer setups are available from the drop-

down list at the bottom of the explorer. These include explorers designed for working with 

lights, objects with missing plug-ins, and more. Last, the Select from Scene command 

and its variants use a modal dialog dedicated to selecting from a text-based list, with no 

editing functions. 

 

1.1.1.5. Command Panel 
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The command panel comprises six user-interface panels that give you access to most of 

the modeling features of 3ds Max, as well as some animation features, display choices, 

and miscellaneous utilities. Only one panel is visible at a time. To display a different 

panel, you click its tab at the top of the command panel 

 

These are the panels: 

 

· Create panel    

Contains controls for creating objects: geometry, cameras, lights, and so on. 

 

· Modify panel   

Contains controls for applying modifiers to objects and editing editable objects such as 

meshes and patches. 

 

· Hierarchy pan l  

Contains controls for managing links in a hierarchy, joints, and inverse kinematics. 

 

· Motion panel   

Contains controls for animation controllers and trajectories. 

 

·  Display panel   

Contains controls that let you hide and unhide objects, along with other display options 

 

·  Utilities panel   

Contains miscellaneous utility programs. 

By default, the command panel appears at the right of the 3ds Max window. You can 

"dock" it along other edges of 3ds Max window or make it a floating panel. See 

Customizing 3ds Max 

 

1.1.1.6. Port view 

Viewport layouts give you a special tab bar for switching quickly among any number of 

different viewport layouts. For example, you might have a four-viewport layout, zoomed 

out for an overall view of your scene from different angles simultaneously, plus several 

different full-screen closeup views of different parts of the scene. The ability to activate 

any of these with a single click can speed your workflow tremendously. The layouts are 

saved with the scene, so you can return to your custom viewports setup at any time. 

 

· Viewport Layouts tab bar (on left side of viewports) 

· Customize Display Right-Click Menu > Viewport Layout Tab 
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Viewport layouts tabs at bottom-left, showing three tabs below the Presets menu button 

The Viewport Layouts tab bar is open by default when you first start 3ds Max, oriented 

vertically on the left side of the viewports. The single tab at the bottom of the bar bears an 

icon that depicts the startup layout. You can add tabs to access additional layouts by 

choosing them from the Presets menu, which opens when you click the arrow button on 

the tab bar. After loading additional layouts onto the bar from the presets, you can switch 

to any layout by clicking its icon. 

 

The Viewport Layouts feature comprises two basic tools: 

 

  1    Viewport Layout tabs  

You add these from the Presets (arrow) menu on the tab bar. You can customize any 

layout by navigating the viewports, changing point-of-view and rendering modes, and 

moving viewport boundaries. You can also set any viewport in any layout to Track View, 

Scene Explorer, or any other Extended Viewport option. 

You can have as many different layouts in a scene as memory permits. Tabs you add in 

a session are saved and loaded with the scene. Saved data includes all pertinent aspects 

of each layout including viewport navigation settings and rendering modes. 

 

 

2 Layout Presets (Standard and Custom) 

Open the Presets menu by clicking the arrow button on the tab bar. By default, this menu 

contains 12 of the standard viewport layouts. To open a new layout, choose any preset 

by clicking it. This also adds a tab for the layout to the tab bar. 
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You can add a custom preset based on any existing tab by right-clicking the tab and 

choosing Save Configuration as Preset. The custom preset remembers the layout 

(number and arrangement of viewports) and the viewport points of view, and when 

the display driver is active, it also remembers the viewport rendering modes. The custom 

preset does not store view transforms (pan/orbit/zoom). Custom presets persist between 

sessions and can be renamed and deleted. 

 

· Managing the Viewport Layouts Tab Bar 

The Viewport Layouts tab bar is, in effect, a toolbar. You can manage it the same way as 

any toolbar in 3ds Max: 

 

i. To float the tab bar, drag it by the top end. 

ii. To dock the floating tab bar, drag it to the left side of the interface, or right-click the 

top and choose Dock  Left. (The tab bar docks to the left side only.) 

iii. To access the toolbars menu, right-click the top end of the tab bar. 

iv. To toggle the tab bar, right-click near the top or left end of any toolbar to open 

the Customize Display Right-Click menu and click the Viewport Layout Tabs item. 

Also, if the tab bar is floating, you can close it by clicking the X button on the title 

bar. 

· Procedures 

Example: To use Viewport Layouts: 

The Viewport Layouts feature can facilitate any number of different workflows in 3ds Max. 

This procedure illustrates one that enables multiple views of a scene plus an extended 

viewport. 

 

i. Start 3ds Max. If the default layout isn't the standard 2 x 2 viewports, use 

the Layout panel to set it. 

ii. 

iii. Use Zoom and Pan to fill the Top viewport with the teapot and the Front viewport 

with the sphere. 

 

sphere, and a box. All three objects appear in all four viewports.

a 
Add  a  few  different  objects  in  the  PeSSPective  viewport,  such  as  a  teapot,  
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Viewport Layouts tab  

i.  

The Viewport Layouts tab bar, the vertical bar to the left of the viewports. The bar 

contains a single tab, which represents the current layout. You'll add a layout by 

loading it from the available presets. Start by clicking the arrow button above the 

tab on the tab bar. The Viewport Layouts Presets menu opens. Because you 

haven't saved any custom presets, it contains only the standard viewport layouts. 

Each item is represented by a thumbnail icon that depicts its layout. 

ii. On the Presets menu, click the icon for the first layout; it resembles a single, 

undivided rectangle. A new tab is added to the tab bar and its layout opens with a 

single, full-screen viewport. It uses the Top wireframe view because that's the 

default single-viewport view from the Layout panel. 

. 

i. 

 
view, then pan, zoom, and rotate the view so you're zoomed in on the teapot.

shaded 
Press the P key to switch it to a PeSSPective viewport and F3 to switch to a 
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ii. Right-click the tab to open the context menu, then click in the Name field and change the 

name to Teapot Closeup. 

 

Check the tooltip for the tab; it's the same as the layout name. 

 

i. Repeat steps 4-6 to create another closeup view for the sphere and name 

it Sphere Closeup. 

ii. Click the arrow button again and this time choose the first preset in the third row. 

This creates a new, fourth tab with two horizontal viewports. Its name is Row 1, 

Row 1. 

iii. In the top-left corner of the upper viewport, click the Top menu header (the one 

between the other two menu headers), then choose Extended Viewports  Track 

View  New. 

A new Track View setup replaces the viewport contents. You can use this layout to 

animate the scene and edit your animation at the same time. Also, note that the upper 

part of the icon on the tab contains horizontal lines to indicate that it contains an 

extended view. 
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iv. Change the tab name to Track View + Front. 

v. Click each of the four tabs in turn and note that it invokes its own viewport setup. 

This shows how you can use the Viewport Layouts feature to switch quickly among 

various viewport setups: viewing the whole scene from different angles 

simultaneously, editing specific objects in a full-screen, closeup view, and 

animating the scene in a single viewport with easy access to Track View. 

You can also delete a layout when you're done with it, removing it and its tab and 

recovering the memory it occupied. 

vi. Save the scene, then right-click the Sphere Closeup tab and choose Delete Tab. 

The layout and its tab disappear. 

Note: The Delete Tab command is not undoable. 

vii. Reset 3ds Max and look at the tab bar. 

The tabs you created are gone. Tabs do not persist between sessions. To use a 

custom layout in different scenes, use the Presets feature as described in the next 

procedure. 

viii. Load the scene from step 13. 

The tabs and setup are restored intact. Tabs and their contents are saved and 

loaded with the scene. 

 

Example:  

To create custom layout presets: 

 

i. Continue from the preceding procedure. 

ii. Click the first (lowest) tab. It should still have the name Quad 4. The standard four-

viewport layout appears. 

iii. Click the top tab: Track View + Front. 

iv. Right-click the Track View + Front tab and click Save Configuration As Preset. 
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v. 

 

vi. 

vii. 

viii. 

ix. 

x. 

xi. To edit the presets, open the presets menu and click the  button to the right of the 

Saved Layout Presets heading. 

The edit fields containing the custom preset names become visible, each with a red X 

button on its right side. 

xii. To change a preset name, click in its edit field and use the keyboard. To delete a preset, 

click its X button. To finish editing, click the  button again or click anywhere outside 

the presets menu. 

 

 

 

 

 

options and viewports showing default views.

Custom Presets feature is particularly useful with layouts containing Extended Viewports 
The same  multi-purpose layout opens, this time showing the torus. This shows that  the 

Choose Track View + Front Preset.

The presets you created a few moments ago are still there.

open the Presets menu.

then 
Reset 3ds Max and add a torus in the center of the grid in the PeSSPective viewport, 

uses the default viewport rendering option as well.

instead  uses  the  default  setting.  And  if  you're  not using  Nitrous  as  the  display  driver,  it 
Wireframe rendering mode. The preset does not remember the viewport transforms, but 
out  view.  Also,  if  you're  using  a  display  driver  other  than  Nitrous,  the  viewport  uses 
zoomed-

the PeSSPective viewpoint that was saved with the preset, but it uses a default 

A  new  layout  opens  showing  the  scene  from  above.  Note  that  the  single  viewport  uses 

Open the Presets menu again and click the Sphere Closeup Preset item.

This shows that you can save a custom preset from any tab, not just the active one.

Closeup, and save it as a second preset.

With  the  Track  View  +  Front  layout  still  active,  right-click  the  next  tab  down,  Sphere 

Close the menu by clicking anywhere outside it.

includes a single entry: Track View + Front Preset.

The  upper  part  of  the  menu  contains  a  new  section  titled  Saved  Layout  Presets,  which 

Open the Presets menu by clicking the arrow button.

The message "Preset is created" appears briefly.
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Saved layout presets dialog box 

 

 
 

Open the Layouts menu by clicking the arrow button on the Viewport Layouts tab bar. 

The tooltip for this button is "Create a New Viewport Layout Tab." To load a new layout 

and tab from any preset on the menu, click its icon. After you load a preset, you can 

customize it by changing the viewport size proportions, point of view, and Extended 

Viewport options, then save it as a new preset. 

The menu entries are as follows: 

a. Saved Layout Presets Lists custom layout presets created by the user with 

Save Configuration as Preset (see preceding). Each preset is listed with a 

representative icon and the name. If no saved custom presets exist, this 

menu section does not appear. 

b.  Rename or Delete Saved Presets Available only when the Saved 

Layout Presets menu section is present; that is, when presets exist. When 

you click this button, the menu entry changes to "Editing Saved Layout 

Presets" and you can edit a preset name by clicking in its field and typing. 

You can also delete a preset by clicking the red X button next to its name. To 

exit this mode, click this button again or click outside the Layouts menu. 

c. Standard Viewport Layouts Lists the viewport setups that come with 3ds 

Max. These are a subset of those available on the Layout Panel. Each setup 

is represented as an icon that depicts the layout. 

 

1.1.1.7. viewport Navigation 

 

At the right end of the status bar are the buttons that control the display and navigation of 

the viewports. 
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· 

 

2D Pan Zoom Mode 

  

 

 Zoom Extents All, Zoom 

Extents All Selected 

 

 
 Maximize Viewport Toggle 

 

 

 

· 

 
 

 

 

 Zoom 

  

another tool.

button  highlights  when  on.  To  turn  it  off,  press Esc,  right-click  in  a  viewport,  or  choose 
Many  of  these  controls  are  modal,  meaning  the  tool  stays  active  for  repeated  use.  The 
peSSPective and orthographic viewport controls.

flyout  and  Maximize  Viewport  toggle,  available  in  all  viewports,  are  included  with  the 
to User viewports as well as viewports like Top, Front, and so on. The Zoom Extents All 
camera, and light viewports all have specialized controls. The term “orthographic” refers

orthographic,
The  navigation  controls  depend  on  the  active  viewport.  PeSSPective, 

Viewport Navigation Controls

[Performance] section of the Initialization file.

The  state  of  the  navigation-button  flyouts  for  all  viewport  types  is  saved  in  the 
changes for PeSSPective viewports.

Some  of  the  buttons  change  for  camera  and  light  viewports.  The  Field  Of  View  button 

Module-6 (LU-1): Develop 3D Models using 3D Studio Max

PeSSPective and Orthographic Viewport Controls
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 Zoom All 

 

 

 Zoom 

Extents/Zoom 

Extents 

Selected 

 

 

 

 
 

 
Pan View 

 

 

  Walk 

Through 

 

 

 Orbit, Orbit 

Selected, Orbit 

Sub-Object 

 

  

 

 

· Camera Viewport Controls 

 

 
 

Note: Camera tools active after selecting Camera. 

Region

or  Zoom 
(PeSSPective)

Button

  Field-of-View 
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 Dolly Camera 

 Target 

 
 Both(Dolly camera ,Target) 

 

  

 
 Roll Camera 

 

 Field-of-View Button 

 

  

 Truck Camera 

 

 Walk Through 

 

Orbit/Pan Camera 

 

 

 

 

 

PersSSPctive
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· Light Viewport Controls 

 
 

 Dolly Light, 

 Target 

 
 Both(Dolly light,Target) 

 

 Light Hotspot 

 
 Roll Light 

 

 
Light Falloff 

 

 
  Truck Light 

 

 

 Orbit/Pan Light 
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iii.  

1.1.1.8.

 
 

A collection of standard primitive objects 

 

or directional light.

spotlight 
that are available in all viewports: orthographic, peSSPective, camera, and 

ii.  Navigating in All Viewports: The topics in this section describe viewport controls

without changing the rendering frame.

2D  Pan  Zoom  Mode: In  2D  Pan  Zoom  Mode,  you  can  pan  or  zoom  a  viewport i. 

Module-6 (LU-1): Develop 3D Models using 3D Studio Max

describe viewport controls available in camera and peSSPective viewports.

section

Navigating  in  Camera  and  PeSSPective  Viewports: The  topics  in  this 

further refine them with modifiers.

using a single primitive. You can also combine primitives into more complex objects, and 
boxes, doughnuts, and ice cream cones. In 3ds Max, you can model many such objects 
Geometric primitives are familiar as objects in the real world such as beach balls, pipes, 

Primitives

the parameters of the associated camera or light object.

navigation  buttons  do  more  than  adjusts  your  view.  They  transform  and  change 
when a viewport with a Camera or Light view is active. The Camera and Light view 
navigation  buttons  are  the  same  with  a  few  exceptions.  The  buttons  are  visible 
Navigating  in  Camera  and  Light  Viewports: The  Camera  and  Light  view v. 

orthographic, user, grid, and shape viewports all share the same viewport controls.

PeSSPective,
iv.  Navigating  in  PeSSPective  and  Orthographic  Viewports:
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3ds Max includes a set of 11 basic primitives. You can easily create the primitives with 

the mouse in the viewport (see Creating an Object), and most can be generated from the 

keyboard as well. These primitives are listed in the Object Type rollout and on the Create 

menu. 

Tip: While creating a primitive that requires two or more steps, such as Cylinder or Torus, 

you can use the mouse to pan and orbit the viewport between steps. To pan the viewport, 

drag with the middle mouse button or scroll the mouse wheel. To orbit the viewport, hold 

down Alt and drag with the middle mouse button or scroll the mouse wheel. 

Also available on the Object Type rollout is the AutoGrid option, which lets you create an 

object on the surface of another object. 

You can convert standard primitive objects to editable mesh objects, editable poly 

objects, and NURBS surfaces. You can also convert primitives to patch objects; see the 

path annotation at Editable Patch (the information at the start of the topic that tells you 

how to create this type of object). 

All primitives have name and color controls and allow you to enter initial values from the 

keyboard. See these topics: 

Object Name and Wireframe Color 

Creating Primitives from the Keyboard 

The remaining rollouts are covered in the topic for each primitive. 

 

· Topics in this section 

 

i. Box 

Box produces one of the simplest of the primitives. Cube is the only variation of 

Box. However, you can vary the scale and proportions to make many kinds of 

rectangular objects, from large, flat panels and slabs to tall columns and small 

blocks. 

ii. Cone 

The Cone feature lets you produce round cones: upright, inverted, and truncated. 

iii. Sphere 

Sphere produces a full sphere or a horizontal portion of a sphere such as a 

hemisphere. You can also "slice" a sphere about its vertical axis. 
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iv. GeoSphere 

Use GeoSphere to make spheres and hemispheres based on three classes of 

regular polyhedrons. 

v. Cylinder 

Cylinder produces a cylinder, which you can "slice" around its major axis. 

vi. Tube 

The Tube primitive produces a cylinder with a concentric hole. The shape can be 

round or prismatic. 

vii. Torus 

Torus produces a ring with a circular cross section, sometimes referred to as a 

doughnut. You can combine three smoothing options with rotation and twist 

settings to create complex variations. 

viii. Pyramid 

The Pyramid primitive has a square or rectangular base and triangular sides. 

ix. Teapot 

The Teapot primitive produces a composite object comprising a lid, body, handle, 

and spout. You can choose to make the whole teapot at once (the default), or any 

combination of parts. Because the Teapot is a parametric object, you can choose 

which parts of the teapot to display after creation. 

x. Plane 

The Plane object is a special type of flat polygon mesh that can be enlarged by 

any amount at render time. You can magnify the size or number of segments, or 

both. Use the Plane object for creating a large-scale ground plane that doesn't get 

in the way when working in a viewport. You can apply any type of modifier to the 

Plane object, such as Displace to simulate a hilly terrain. 

xi. Text Plus 

Text Plus provides an all-in-one text object. You can create a spline outline or 

solid, extruded, beveled geometry. Additional options let you apply different fonts 

and styles on a per-character basis and add animation and special effects. 

 

1.1.1.9. Transforms 

A transform is an adjustment of an object’s position, orientation, or scale, relative to the 

3D world (or world space) in which you’re working. 
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Changing a model by changing its position, rotation, or scale 

You can apply three basic types of transform to an object: 

 

· Position 

· Rotation 

· Scale 

And a fourth transform command lets you position an object automatically on an 

underlying surface: 

 

· Placement 

This section presents brief topics to help you quickly start learning how to transform 

objects and how to animate your transforms. 

· Failure to Move or Rotate 

In some cases, an object might fail to move or rotate, even when the proper command is 

active, and the object is selected. This could be due to one of the following reasons: 

i. The object is frozen. 

ii. A transform controller has been assigned to the object. See Animation Controllers. 

iii. Inverse Kinematics mode is on and the preference called Always Transform Children of 

the World is off. See Introduction to Inverse Kinematics (IK). 

 

To transform an object using the main toolbar: 

i. On the main toolbar, click one of the three transform buttons: (Select and Move), (Select 

and Rotate), or (Select and Uniform Scale). These buttons are usually referred to as 

Move, Rotate, and Scale. 

Alternatively, to position an object on another object's surface, click (Select and Place). 

ii. Position the mouse over the object you want to transform. 

a. If the object is already selected, the cursor changes to indicate the transform. 

b. If the object is not selected, the cursor changes to a crosshair to show that 

the object can be selected. 

c. Drag the mouse to apply the transform. 

If you start the drag over an unselected object, it becomes selected and is also 

transformed. 

You can restrict transforms to one or two axes easily with the Using Transform Gizmos. 

 

· To cancel a transform: 

Right-click while dragging the mouse. 

· To transform an object from the quad menu: 

d. Right-click a selected object. The quad menu lists the available transforms. 

e. Choose a transform: The equivalent transform button is activated on the 

main toolbar. 

f. Drag the object to apply the transform. 

· To use the Transform Type-In dialog: 
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i. Choose Edit menu  Transform Type-In to display the dialog. 

ii. Apply a transform to a selected object. 

iii. You can do any of the following, switching from one to the other as required. 

a. Type a value in an axis field and press Enter to apply the transform change 

to the selection. 

b. Drag a spinner in an axis field to update the selection. 

c. Drag the object to apply the transform and read the resulting change in the 

dialog. 

For example, if Move is active, the dialog fields read out both the absolute and offset 

positions of the selected object in world space. If no object is selected, the fields turn 

gray. 

· To use transform type-in on the status bar: 

i. Select an object or a group of objects. 

ii. On the main toolbar, choose a transform (Move, Rotate, or Scale) to perform on 

the objects. 

iii. On the status bar, you can do any of the following, switching from one to another 

as required: 

a. Type a value in an axis field and press Enter to apply the transform change 

to the selection. The Absolute/Offset toggle, to the right of the X, Y, and Z 

fields, lets you switch between entering values that are absolute (in world 

space) or offset (relative to the selection's present position, orientation, and 

dimensions). 

b. Drag a spinner in an axis field to update the 

selection. 

c. Drag the object to apply the transform and read 

the resulting change in the X, Y, and Z fields. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tip: To see the Z field, 
drag the transform 
type-in portion of the 
toolbar while a pan 
hand is visible 

Remember 
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1.1.1.10. Develop a Box Model using different modeling Techniques 

 

· Create a box with Nurbsstep by step  

 

 

 
 

 

i. Open 3d max 

ii. Draw an ellipse from shape tool 

iii. Copy the ellipse 

iv. Convert to NURBS modeling with right click on ellipse shape 

v. Attach box ellipse with create U loft surface tool 

vi. Create a path for box according to the given shape 

vii. Click on tool menu and select populate panel tool  

viii. Then appeared a dialogue box click on + option    

ix. Click on modify tool and select display line parameter ISO only 

x. Apply amount in U line and V line according to the shape   

xi. Click on tool menu and select populate panel  

xii. Then appear a dialog box 

xiii. Click on process option  
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· Create a box with polygon step by step  

 

i. Open 3d max 

ii. Click on create icon from command panel  

iii. selectee and click geometry icon  

iv. after appearing stander primitives option click on plane option  

v. draw plane object on display  

vi. set parameters and give the size 2' x 2'  

vii. click on modify icon when appear the peramative option then set the length sage and 

width sages 1' x 1'  

viii. right click on object  

ix. Appear dialog box  

x. Select option convert to + editable poly and click 

xi. Then appear selection dialog box with given five icons in red color (vertex, edge, border, 

polygon,element) 

xii. Click on polygon  

xiii. Click on top surface of object 

xiv. Then extrude from extrude setting 

xv. Give the height amount given on the object 

xvi. After given size click on the option     
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· Create a box with spline step by step  

 
 
 
 

 
 
 
 

 

i. open 3d max  

ii. click on the top view with short key 'T' 

iii. click on create icon from command pane 

iv. select the shape icon then appear the object type option 

v. select and click on the rectangle option 

vi. Given the size 1' x 1' 

vii. draw a rectangle on display 

viii. then click on modify icon and click on the modify list 

ix. select extrude command  

x. enter the amount (Height size 1 ‘) according to the dimension  

xi. then Enter 

 

 
useful short key 

W-for move 
E- for Rotate 
R-for scale 

 
 

Remember 
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1.2. Use Geometry & Shapes to make 3D Objects according to given Specification  

 

“Geometry” is the part of mathematics that studies the size, shapes, positions and dimensions of things 

such as Squares, circles and triangles are some of the simplest shapes in flat geometry. Cubes, cylinders, 

cones and spheres are simple shapes in solid geometry 

  

a “shape “can be defined as the form of an object or its outline, outer boundary or outer surface. ... We can 

find different basic shapes such as the two-dimensional square, rectangle, and oval or the three-

dimensional rectangular prism, cylinder, and sphere in the objects we see around us 

  

As some more professions use geometry in order to do their job properly. For example, computer imaging, 

something that is used nowadays for creating animations, video games, designing, and stuff like that, are 

created using geometric concepts. Also, geometry is used in mapping 

Shapes are at the root of graphic design. They are figures and forms that make up logos, illustrations, and 

countless other elements in all types of designs. Shapes help the designer to add interest or organize 

elements of a design. They are not strictly ornamental, either, as shapes can have symbolic meanings, 

invoke feelings, or be used to direct the eye to the most important information. 

 

 

1.2.1. Develop 3D object by using the following 3D Max Basic tools 

A shape is an object made from one or more curved or straight lines. 3ds Max includes the 

following shape types: splines and NURBS curves. 

·  Create panel >  Shapes 

· Standard menu: Create menu > Shapes 

· Enhanced menu: Objects menu > Shapes 

 

1.2.1.1. Using Shapes 

Shapes are 2D and 3D lines and groups of lines that you typically use as components of 

other objects. Most of the default shapes are made from splines. You use these spline 

shapes to do the following: 

 

· Render as is 

· Generate planar and thin 3D surfaces 

· Define loft components such as paths, shapes, and fit curves 

· Generate extrusions and surfaces of revolution 

· Define motion paths 

3ds Max supplies 11 basic spline shape objects, two types of NURBS curves, and five 

extended splines. You can create these shapes quickly with mouse or keyboard entry 

and combine them to form compound shapes. 

 

1.2.1.2. Creating Shapes 



Teaching and Learning Guide: Information Technology (CAD) 3D Studio MAX 

 

| 38 

Module-6 (LU-1): Develop 3D Models using 3D Studio Max 

 
  

To access the shape-creation tools, go to the  Create panel and click  (Shapes). 

You'll find the standard shapes under Splines in the category list, Point Curve and CV 

Curve under NURBS curves, and WRectangle, Channel, Angle, Tee, and Wide Flange 

under Extended Splines. 

As you add plug-ins, other shape categories might appear in this list. 

The Object Type rollout contains the spline creation buttons. You can combine one or 

more of these spline types into a single shape. 

· Create Shape from Edges 

You can create shapes from edge selections in mesh objects. In Edit/Editable Mesh 

objects, at the Edge sub-object level, on the Edit Geometry rollout, is a button called 

Create Shape from Edges that creates a spline object based on selected edges. 

Similarly, with Editable Poly objects, you can use the Create Shape from Selection tool at 

the Edge sub-object level. 

 

 

1.2.1.3. Editable Splines 

You can convert a basic spline to an editable spline object. The editable spline has a 

variety of controls that let you manipulate it and its sub-objects directly. For example, at 

the Vertex sub-object level you can move vertices and adjust their Bezier handles. 

Editable splines let you create shapes that are less regular, more free-form than the basic 

spline options. 

When you convert a spline to an editable spline, you lose the ability to adjust or animate 

its creation parameters. 

 

1.2.1.4. Renderable Shapes 

When you use a shape to create an object by lofting, extruding, or other means, the 

result is a renderable 3D object. Alternatively, you can render a shape without first 

making it into a 3D object. Follow these steps to render a shape: 

 

· On the Rendering rollout of the shape's creation parameters, turn on Enable in Renderer. 

· Choose the cross-section type: Radial or Rectangular. Then adjust dimensions and other 

settings according to your needs. 

· If you plan to assign a mapped material to the spline, turn on Generate Mapping Coords. 
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When Enable In Renderer is on, the shape is rendered using a circular or rectangular 

cross-section. Mapping coordinates are generated with U mapped once around the 

perimeter and V mapped once along the length. 

3ds Max provides control over renderable shapes; viewports, including wireframe 

viewports, can display the geometry of renderable shapes. You can have different 

rendering settings for the viewport or use the same as for the renderer. 

The Steps settings affect the number of cross-sections in the renderable shape. 

Please observe the following: 

· When you apply a modifier that converts a shape into a mesh (such as Extrude or Lathe), 

the object automatically becomes renderable, regardless of the state of the Enable in 

Renderer switch. Enable in Renderer is necessary only to render an unmodified spline 

shape in the scene. 

· As with all objects, a shape's layer must be both visible and renderable for the shape to 

render. 

· The Object Properties dialog also has a Renderable switch, which is on by default. For a 

shape to render, both this switch and the Rendering rollout  Enable In Renderer switch 

must be on. 

 

1.2.1.5. Shapes as Planar Objects 

A straightforward usage for shapes is as 2D cutouts or planar objects. Examples include 

ground planes, text for signs, and cutout billboards. You create a planar object by 

converting a shape to an editable surface, either directly or with a modifier. For example, 
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select the shape, then right-click to open the context menu and choose Convert To 

Convert to Editable Poly. 

 
2D objects 

You can also convert a 3D shape (for example, a shape whose vertices have been 

moved vertically away from the construction plane by different amounts) to create a 

curved surface. The resulting 3D surface often requires manual editing of faces and 

edges to smooth surface ridges. 

 

1.2.1.6. Extruded and Lathed Shapes 

You can apply modifiers to a shape to create a 3D object. Two such modifiers are 

Extrude and Lathe. Extrude creates a 3D object by adding height to a shape, while Lathe 

creates a 3D object by rotating a shape about an axis. 

 

 
Initial text shape with extruded shape below 

 
Lathed object with initial shape on right 

 

1.2.1.7. Lofting Shapes 

You create Lofts by combining two or more splines in special ways. Shapes form the 

lofting path, loft cross-sections, and loft fit curves. 
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1.2.1.8. Shapes as Animation Paths 

You can use shapes to define how the position of an animated object changes over time. 

You create a shape and use it to define a path that some other object follows. 

 

Some possible ways for a shape to control animated position are: 

 

· You can use a Path constraint to use a shape to control object motion. 

· You can convert a shape into position keys using the Motion panel  Trajectories 

Convert From function. 

 

1.2.1.9. Helper 

 Create panel >  (Helpers) > Standard > Object Type rollout 

· Standard menu: Create menu > Helpers 

· Enhanced menu: Objects menu > Helpers / More Helpers / Particle Flow Helpers 

 

The helpers in this section serve mainly as precision and drawing aids. 

· Dummy Helper 

A Dummy helper object is a wireframe cube with a pivot point at its geometric center. It 

has a name but no parameters, you can't modify it, and it doesn't render. Its only real 

feature is its pivot, used as a center for transforms. The wireframe acts as a reference for 

transform effects. 

 

· Expose Transform Helper 

The Expose Transform helper exposes values of non-keyed objects for use in 

expressions and scripts. This lets riggers and animators access a select set of transforms 

for an object, and between an object and its parent, such as a bone in an IK chain. For 
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example, using the Expose Transform helper, you could write a script or use parameter 

wiring that tests the angle of an character's arm bone that's controlled by IK (thus, has no 

keys), and once it exceeds a specific value, rotate the corresponding clavicle bone to 

deform the shoulder area. 

 

· Grid Helper 

The grid, also called User Grid or Custom Grid, is a 2D parametric object with 

adjustments for overall size and grid spacing. You can move and orient user grids 

anywhere in world space. 

 

· Point Helper 

Point provides a specific location in 3D space that can be used as a reference or by other 

program functions. 

 

· Tape Helper 

Tape provides an on-screen "tape measure" for determining and setting distances. The 

tape is composed of two named objects, in the same way targeted lights and cameras 

are. By default, these are named Tape### and Tape###. Target (the ### is a three-place 

number). The tape and target icons are connected by a line representing the current 

distance between them. 

· Protractor Helper 

Protractor measures the angle between a point and any two objects in your scene. 

 

· Compass Helper 

Compass displays as a non-rendering compass rose, with indicators for North, South, 

East, and West. A compass is part of a Daylight or Sunlight system; you create a 

compass automatically when you create sunlight. In a Sunlight system, the orientation of 

the compass indicates the orientation of the scene, relative to the path of the sun. 

 

1.2.1.10. SPACE WARPS 

Space warps create "force fields" that deform other objects, creating the effect of ripples, 

waves, blowing wind, and so on. 

 Create panel >  (Space Warps) 
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· Using Space Warps 

follow these steps: 

i. Create object 

ii. Create a space warp. 

iii. Bind objects to the space warp. 

Note: On the main toolbar, click  (Bind To Space Warp), and then drag between the 

space warp and the object. 
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1.2.2. Demonstrate file link setting 

 

1.2.2.1. Merge Autodesk 3D Max scene File  

Follow these Steps: 

i. Quick Selection àImport àMerge  

 

fig 1.1 

 

 

ii. Select object from library (lick select a Car) then click on open 
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fig 1.2 

 

iii. Click on invert and ok 

 

 
fig 1.3 
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Fig 1.4 

 

1.2.2.2. import/Link DWG File 

Follow these Steps: 

i. Go to Quick selection and click on import then appear a Dialog Box 

 

 
Fig 2.1 
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ii. Select the folder Tauseef and select DWG File and open 

 
Fig 2.2 

 
Fig 2.3 

iii. Click on the import option 
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Fig 2.3 

 

 

1.2.2.3. link FBX and RVT File 

Follow these Steps:  

i. Go to the Quick selection and import the FBX file link and click on it then appear the 

open dialog box and open the FBX file for import 

 

 
Fig 3.1 
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Fig 3.2 

 

ii. Then appear the manage link dialog box  

iii. click on the attach this file option  

 
Fig 3.3 

 

 



Teaching and Learning Guide: Information Technology (CAD) 3D Studio MAX 

 

| 50 

Module-6 (LU-1): Develop 3D Models using 3D Studio Max 

 
  

iv. Import FBX File in 3D max 

 
Fig 3.4 

 

v. link RVT File 

vi. Go to the Quick selection and import the RVT file link and click on it then appear the open 

dialog box and open the RVT file for import 

 

 

Fig 4.1 
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vii. Select the file then click on the open option 

 
 

Fig 4.2 

 

 

viii. Then appear the manage link dialog box  

ix. click on the attach this file option  

 

 

 



Teaching and Learning Guide: Information Technology (CAD) 3D Studio MAX 

 

| 52 

Module-6 (LU-1): Develop 3D Models using 3D Studio Max 

 
  

 
Fig 4.3 

 

 

 

 
Fig 4.4 

 

 

1.2.2.4. Link SketchUp File 

 

i. Link sketchup file 

ii. Follow these steps 

iii. Quick toolbar > import 

iv. Select skp file 

v. Uncheck camera and day light 
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vi. Press OK  

Note: Sketchup file must be save in “Sketchup version 8  
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Practice -1 

Develop a dice of size 250 mm with mention tools 

 

 

 

Create a Dice step by step  

 

1) Open 3d max 

2) For change unit in mm select customize menu and click on customize and set the unit from the unit setup 

3) draw a box from command panel with create box icon 

4) Put the size according to the given dimensioning object from parameters option then enter  

5) From shape tool draw a circle 

6) Marge the circle with rectangle object  

7) Extrude circle 

8) Subtract circle from rectangle   
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Practice -2 

 
Develop a 3d Led Illusion Lamp of size 18" in height using 2 different colors 

 

Create a Led lump step by step  

 

1) Open 3d max 

2) Set unit from customize menu  

3) Draw a circle for base of LED and editing with poly 

4) draw a line in center of base of lamp from shape tools 

5) Extrude all necessary object  

6) Use dome command from stander parameters for lamp 

7) Modification in object with poly molding 

8) Draw a line for extension  

9) Apply material for electric switch   
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Learning Unit 2: Modify objects 

 

Objectives:  

In this learning unit the modifier is blow the following application by 

applying different modifier for modification and also explain the 

modifier stack control. 

Import the 2D DWG Drawing t into 3D max studio and working with it 

also explain in this units  

 

Learning Outcomes: 

After completion of this Learning Unit you will be able to: 

v Modify parameter of 3D objects according to given specification. 

v Apply modifiers for object manipulation to meet the specific 

requirement. 
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2. Modify object. 

 
Modification in 3D models by using different modifiers  

 

2.1. Modify 3D models using different modifiers. 

 
One of the most important expected for applying different types of modifiers like 

· Edit mesh 

· Delete mesh 

· Extrude  

· Bend 

· Bevel 

 

2.1.1. Edit Mesh 

The Edit Mesh modifier provides a variety of tools for editing all sub-object levels of the selected 

object: Vertex, Edge, and Face/Polygon/Element. 

 

2.1.1.1. Vertex  

Vertices are points in space: they define the structure of faces. When vertices are moved 

or edited, the faces they form are affected as well. Vertices can also exist independently; 

such isolated vertices can be used to construct faces but are otherwise invisible when 

rendering. 

 

i. Select an editable mesh object. > Modify panel > Selection rollout > Vertex 

ii. Select an editable mesh object. > Modify panel > Modifier Stack display > Expand 

Editable Mesh. > Vertex 

iii. Select an editable mesh object. > Quad menu > Tools 1 quadrant > Vertex 

 

At the Editable Mesh (Vertex) sub-object level, you can select single and multiple vertices 

and move them using standard methods. 

 

2.1.1.2. Edit Mesh step by step in vertex 

i. Create a Box for vertex 
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ii. Select box (object) and click on the modify tool  

iii. Set parameters according length, width, height  

iv. Set segments of length, width, height 

v. Select Edit Mash from the modifier list  

vi. Select vertex and apply 

 

 
 

Fig 1.2 
 
 

2.1.1.3. Edge  

An edge is a line, visible or invisible, forming the side of a face and connecting two 

vertices. Two faces can share a single edge. 

 

i. Select an editable mesh object. > Modify panel > Selection rollout > Edge 

ii. Select an editable mesh object. > Modify panel > Modifier stack display >  Expand the 

Editable Mesh entry. > Edge 

iii. Select an editable mesh object. > Quad menu > Tools 1 quadrant > Edge 
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At the Editable Mesh (Edge) sub-object level, you can select single and multiple edges 

and transform them using standard methods. 

 

· Edit Mash step by step in Edge 

a) Select box (object) and click on the modify tool  

b) Set parameters according length, width, height  

c) Set segments of length, width, height 

d) Select Edit Mash from the modifier list  

e) Select edge and apply 

 

 
 

2.1 
 
 

2.1.1.4. Face  

A face is the smallest possible mesh object: a triangle formed by three vertices. Faces 

provide the render able surface of an object. While a vertex can exist as an isolated point 

in space, a face cannot exist without vertices. 
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i. Select an editable mesh object. > Modify panel > Selection rollout > Face, 

ii. Select an editable mesh object. > Modify panel > Modifier stack display >  Expand the 

Editable Mesh entry. > Face, 

iii. Select an editable mesh object. > Quad menu > Tools 1 quadrant > Face, 

iv. At the Editable Mesh (Face) level, you can select single and multiple faces and transform 

them using standard methods.  

 

· Edit Mash step by step in Face 

 

i. Select box (object) and click on the modify tool  

ii. Set parameters according length, width, height  

iii. Set segments of length, width, height 

iv. Select Edit Mash from the modifier list  

v. Select Face and apply  

 

 
Fig 2.3 
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2.1.1.5.   Polygon  

A polygon is the smallest possible mesh object: A Rectangle formed by four 

 
i. Select an editable mesh object. > Modify panel > Selection rollout > Polygon 

ii. Select an editable mesh object. > Modify panel > Modifier stack display >  Expand the 

Editable Mesh entry. > Polygon 

iii. Select an editable mesh object. > Quad menu > Tools 1 quadrant > Polygon. 

 

At the Editable Mesh (polygon) level, you can select single and multiple faces and 

transform them using standard methods. This is also true for the Polygon and Element 

sub-object levels;  

 

· Edit Mash step by step in Polygon 

 

i. Select box (object) and click on the modify tool  

ii. Set parameters according length, width, height  

iii. Set segments of length, width, height 

iv. Select Edit Mash from the modifier list  

v. Select polygon and apply  

 

 

Fig 2.4 
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2.1.1.6. Element  

A elementis the smallest possible mesh object: a overall formed.by all sides 

 
i. Select an editable mesh object. > Modify panel > Selection rollout > Element 

ii. Select an editable mesh object. > Modify panel > Modifier stack display >  Expand the 

Editable Mesh entry. >Element 

iii. Select an editable mesh object. > Quad menu > Tools 1 quadrant Element. 

 

At the Editable Mesh (Element) level, you can select single and multiple faces . 

 

· Edit Mash step by step in Element 

 

i. Select box (object) and click on the modify tool  

ii. Set parameters according length, width, height  

iii. Set segments of length, width, height 

iv. Select Edit Mash from the modifier list  

v. Select Element and apply  

 

 

 
Fig 2.5 
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2.1.2. Delete Mash 

Delete Mesh provides parametric deletion based on the current sub-object selection level in the 

stack. The possible choices are faces, vertices, edges, and objects. Apply the Delete Mesh 

modifier to delete the geometry selected at that sub-object level. 

 

i.  Modify panel > Make a sub-object selection. > Modifier List > Delete Mesh 

ii. Standard menu:  Modify panel > Make a sub-object selection. > Modifiers 

menu > Mesh Editing > Delete Mesh 

iii. Enhanced menu:  Modify panel > Make a sub-object selection. > Modifiers 

menu > Geometry (Convert to Mesh) > Delete Mesh 
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· Delete Mash step by step  

i. Select box (object) and click on the modify tool  

ii. Set parameters according length, width, height  

iii. Set segments of length, width, height 

iv. Select Edit Mash from the modifier list  

v. Select polygon and delete the mesh 

 

2.1.3. Extrude 

The Extrude modifier adds depth to a shape object and makes it a parametric object. 

 

· Extrude object step by step  

i. Select a shape. >  Modify panel > Modifier List > Object-Space Modifiers > Extrude 

ii. Standard menu: Select a shape. > Modifiers menu > Mesh Editing > Extrude 

iii. Enhanced menu: Select a shape. > Modifiers menu > Spline > Extrude (Spline) 
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iv. Above: Spline before extrusion 

v. Below left: Extruded spline with Cap End off 

vi. Below right: Extruded spline with Cap End on 

 
Note: Amount sets the depth of the extrusion.  

 

 

2.1.3.1. Amount 

Sets the depth of the extrusion. 

 

 

2.1.3.2. Segments 

Specifies the number of segments that will be created in the extruded object. 
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2.1.4. Bend 

The Bend modifier lets you bend the current selection up to 360 degrees about a single axis, 

producing a uniform bend in an object's geometry. You can control the angle and direction of the 

bend on any of three axes. You can also limit the bend to a section of the geometry. 

 

· Bend object step by step  

 

i.  Modify panel > Make a selection. > Modifier List > Object-Space Modifiers > Bend 

ii. Standard menu: Make a selection. > Modifiers menu > Parametric Deformers > Bend 

iii. Enhanced menu: Make a selection. > Modifiers menu > Geometry (Parametric) > Bend 

 

Bend applied to a streetlight model 

 

 
 
 

2.1.4.1. Parameters rollout 
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2.1.5. BEVEL 

The Bevel modifier extrudes shapes into 3D objects and applies a flat or round bevel to the 

edges. 

Bevel lets you extrude a shape up to four levels and specify a different outline amount for each 

level. A common use for this modifier is to create 3D text and logos, but you can apply it to any 

shape. 

 

 
 

2.1.5.1. Beveled text 

Use the Bevel modifier: 

Create a shape such as a Rectangle spline or Circle spline. 

With the shape selected, choose the Bevel modifier from the Modify panel or Modifiers 

menu. 

 

On the Modify panel, choose from the following options: 

 

· Capping:  

Choose Start and/or End to cap the end with the lowest or highest local Z value, 

respectively. When either is off, the respective end is open. 

 

· Cap Type:  

Choose Morph to create cap faces suitable for morphing, or Grid to create cap faces in a 

grid pattern. 

The Grid option deforms and renders better than Morph capping. 

 

· Surface:  

Choose Linear Sides for straight-line interpolation between segments, or Curved Sides 

for segment interpolation that follows a Bezier curve. 

For visible curvature, use multiple segments with Curved Sides. 

 

· Segments: 

The number of intermediate segments between each level. 
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2.2. Apply modifiers for object manipulation to meet the specific requirements.

Modifiers provide a way to sculpt and edit objects. They can change the geometry of an object, and its 

properties. 

 

2.2.1. work with parameters of modifier to modify object  

The Modify panel provides controls for editing object parameters as well as applying modifiers to 

objects and adjusting modifier settings. It also contains the modifier stack, a powerful tool for 

viewing and changing an object's edit history. 

 

 
 

Modify panel tabs  

i. Command panel tabs 

ii. Name and color fields 

iii. Modifier list (drop-down) 

iv. Modifier stack 

v. Modifier stack tools 

vi. Parameters rollout 
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· Use the Modify panel (General): 

i.  Select an object.  

ii. On the Command panel, click the  Modify tab to display the Modify panel. The name 

of the object appears at the top of the Modify panel, and the remainder of the panel 

displays settings for the object or the modifier at the top of its stack. 

iii. You can now do any of the following: 

iv. Change the parameters for the object. As you change these parameters, the object 

updates in the viewports. 

v. Apply a modifier to the object. 

vi. View a list of the object's modifiers in the Modifier Stack display. You can change the 

active modifier (that is, the one whose settings appear on the Modify panel) by clicking it 

in the Modifier Stack display. 

vii. Change the parameters for the active modifier. As you change these parameters, the 

object updates in the viewports. 

viii. Collapse the stack to create an editable surface such as an editable poly. 

 

· Apply a modifier from the Modifier List: 

i.  Select an object. 

ii. On the Command panel, click the  Modify tab to display the Modify panel. On the 

Modify panel, click the Modifier List to open the list of modifiers. 

iii. Scroll through the list to find the modifier you want. You can use any standard method: 

iv. From the keyboard, press up arrow or down arrow to scroll one item at a time, 

press Page Up or Page Down to scroll in screen-height increments, or 

press Home or End to jump to the top or bottom of the list. The name of the chosen 

modifier is highlighted, and the name appears at the top of the list. 

 

Tip: If you know the modifier name, you can jump to its section by pressing the keyboard 

key corresponding to first letter of the name. To cycle through all modifiers starting with 

that letter, press the key repeatedly. 

· With the mouse, slide the scroll bar on the right side of the list, or scroll the mouse 

wheel. 

i. Apply the modifier: 

ii. If using the mouse, click the modifier name. 

iii. If using the keyboard, press Enter to apply the highlighted modifier. 
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2.2.2. Modifier Stack Controls 

The modifier stack controls appear near the top of the Modify panel, just below the Modifier List. 

The modifier stack ("stack" for short) contains the accumulated history of an object, including its 

creation parameters and the modifiers applied to it. At the bottom of the stack is the original 

object. Above the object are the modifiers, in order from bottom to top. This is the order in which 

modifiers are applied to the object's geometry. 

Make a selection. > Modify panel 

 

 
 

· Instances and References in the Modifier Stack Display 
In the modifier stack display, objects and modifiers appear in normal type unless they are 

an instance or a reference. Here is how instances and references appear in the stack 

display: 

 

i. The name of an instanced object appears in boldface. 

ii. The name of a modifier appears in boldface if it is part of an instanced pipeline. 

iii. If a modifier is applied to two or more pipelines, it is called an instanced modifier. Its 

name appears in italic. 

iv. If a modifier is instanced and part of an instanced pipeline, its name appears in boldface 

and italic. 

 

Top: Instanced modifier displayed in italic (modifier applied to two objects) 

Bottom: Instanced modifier in an instanced pipeline displayed in italic and boldface 

 

 

 
 

 

a) A referenced object appears with a dark bar above it. Modifiers below the bar 
are part of the current pipeline. Modifiers above the bar are unique to the 
reference object. 

Note: You can also create instances of a reference. In this case, the modifier 

above the reference bar apply to the reference and to its instances. 

 

b) A modifier above the reference object bar can itself be an instance and 
appear in other pipelines, in which case its name would be italic (either plain 
or boldface). 
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Top: Object reference shows a bar in the pipe 

Bottom: Modifier applied to reference is not bold, as it is unique to this reference 

 

2.2.2.1. Make Unique   

The Make Unique button makes a pipeline or a modifier instance specific to the selected 

object. When you highlight the base object and then click Make Unique, the whole 

pipeline becomes unique. When you highlight a boldface modifier and then click Make 

Unique, this also makes the pipeline unique. If the modifier is an instanced modifier that 

belongs to an instanced pipeline (it appears in boldface and italic), clicking Make Unique 

makes the modifier unique but not the entire pipeline (the modifier's name is no longer 

italic, but it is still bold). For more information see How Instanced Modifiers Work and 

Transforms, Modifiers, and Object Data Flow. 

 

· Most-Recently Used Modifiers 
3ds Max caches the results of evaluating most-recently used modifiers. This means that 

in general, you can see results more quickly as you move among modifiers on the stack. 

To conserve memory use, the list of most-recently used modifiers has a fixed length. 

Once the list is full, adding a new modifier removes the oldest modifier in the list. By 

default, the list length is 1. You can increase it by adding an MRUModSize entry to the 

[Performance] section of the initialization file, 3dsmax.ini. For example: 

MRUModSize=10 

A good rule of thumb for this value is 10, but results will vary depending on how much 

main memory your system has. 

 

· Window  

 
The Modifier Stack 
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2.2.2.2. Modifier List 

 
 

The Modifier List lets you choose a modifier to add to the stack. When you choose an 

Object-Space modifier from this list, it appears above the object, or above the modifier 

currently highlighted in the stack. When you choose a World-Space modifier from this list, 

it appears at the top of the stack. 

 

2.2.2.3. Use Pivot Points 

The first item in the Modifier List is the Use Pivot Points toggle. It is available only when 

multiple objects are selected. 

When Use Pivot Points is on, 3ds Max uses the pivot point of each object as the center of 

a modifier's operation. For example, if you bend a line of trees around the Z axis, they all 

bend along their trunks. 

When Use Pivot Points is off, 3ds Max calculates a central pivot point for the entire 

selection set and modifies the selection as a whole. For example, if you bend a line of 

trees around the Z axis, trees at the end of the line deform more than those at the center 

where the pivot is located. 

The Use Pivot Points setting persists, so that applying modifiers to different sets of 

objects during the current session always uses the same setting. 

 

Note: Be sure to set Use Pivot Points to the desired value before you apply the modifier 

to multiple objects. You can't change the setting afterward, although you can delete the 

modifier and start over without deselecting the selection set. 

 

 

2.2.2.4. Modifier Buttons 

Between the Modifier List and the stack display, you can optionally display up to 32 

buttons. This provides a shortcut for adding modifiers to the stack. 

 

 
 

i. To toggle the modifier buttons, click  (Configure Modifier Sets, below the stack 

display) and choose Show Buttons. 

ii. To customize the button set, click  and choose Configure Modifier Sets. 
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2.2.2.5. Stack Display 

When a modifier's button is visible, clicking the button adds the modifier to the stack. 

Object-space modifiers are applied immediately above the currently selected object or 

modifier. World-space modifiers are applied at the top of the stack. 

 
The modifier stack is organized as follows: 

 

i. At the bottom of the stack, the first entry always lists the object type. Click this entry to 

display the object's creation parameters so you can adjust them. 

ii. When you click to choose an entry in the modifier stack, its background highlights to 

show that the entry is current, and that the object's or modifier's parameters are available 

for adjusting, in rollouts that appear beneath the stack display. 

iii. Above the object itself are entries for object-space modifiers. Click a modifier entry to 

display the modifier's parameters so you can adjust them. 

iv. This section lets you go back to any modifier you've applied and adjust its effect on the 

object. You can also delete the modifier from the stack, canceling its effect. 

 

Note: 3ds Max applies transforms after it applies object-space modifiers but before it 

applies space warps or world-space modifiers. 

 

The top of the stack shows which space warps and world-space modifiers the object 

uses. For example, if the object were bound to a Ripple space warp, an entry in the top 

section would read Ripple Binding. 

 

 To the left of each modifier in the stack is a light-bulb icon. When the bulb appears 

white, the modifier is applied to the stack below it. When the bulb appears gray, the 

modifier is turned off. Click to toggle the on/off state of the modifier. 

 

Note: You can also turn off the effect of modifiers in viewports but not in renderings, or 

vice versa. The light-bulb icon changes to show these states as well. See Modifier Stack 

Right-Click Menu. 

 

 If the modifier has sub-controls such as a center or a gizmo, the stack also shows a 

small plus/minus icon. Click this icon to open or close the hierarchy. 

 

 
 

Opening a modifier's hierarchy to access sub-controls 

 

 
 

When the hierarchy is open, you can select a sub-control, such as a gizmo, and then 

adjust it. The available sub-controls vary from modifier to modifier. 
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Objects that have a sub-object hierarchy, such as editable poly, also show a collapsible 

hierarchy in the modifier stack. 

To work at a sub-object level, click the + icon to expand the hierarchy, then click to select 

the sub-object level. Controls for that particular level or type of sub-object appear in 

rollouts below the stack display. 

Certain types of sub-objects display an icon at the right of the stack, to help you see 

which sub-object type you are adjusting. 

 

 
 

Expanding an object's hierarchy to access sub-object levels 

 

 

 
 

2.2.2.6. Tool Buttons 

Below the stack display is a row of buttons for managing the stack. 

· Pin Stack  

Locks the stack to the currently selected object so it remains with that object regardless 

of subsequent changes in selection. The entire Modify panel is locked to the current 

object as well. 

Pin Stack is useful for transforming another object while keeping your place in the 

modified object's stack. 

 

· Show End Result  

Shows the selected object as it will appear after all modifications in the stack have taken 

place, regardless of your current position in the stack. When this toggle is turned off, the 

object appears as modified up to the current modifier in the stack. 
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· Make Unique  

Converts an instanced modifier to a copy that's specific to the current object. See Make 

Unique. 

· Remove Modifier  

Deletes the current modifier or unbinds the current space warp. 

 

· Configure Modifier Sets  

Click to display the pop-up Modifier Sets menu. 
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Practice -1 

1. Import 2D AutoCAD drawing and convert it into 3D model by using 3D Max 

 

· Open AutoCAD software 

· Draw 2D Drawing and save 

 

 

 
    Fig 2.1 
 
 
 
 

1) Open 3D Max software 

2) Click on the Quick access tool bar  

3) Select the import option from Quick access tool bar  
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4) Appear a dialog box (select file to import) 

5) Select the path 3D  

6) Click on open 

 

 
 

7) Appear a dialog box AutoCAD dwg/Dxf import option 

8) Select layer option  

9) Click on none option  

10) Select 3d layer only 

11) Click ok 
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12) Open 2D AutoCAD house plan file in 3D Max 
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2. How to convert 2D AutoCAD dwg in 3D model by using 3D Max 

1) Click on modify icon in 3D Max 

2) Select modifier list  

3) Open extrude option and click on it 

 

 
 

4) Given the amount according to the height of house plan (like 12’) and extrude 
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3. How to subtract Door or window in 3D modeling 

1) Enter, T, for top view  

2) Draw a rectangle for window subtraction  

 
 

3) Change in to 3d view from home option  

4) Extrude the rectangle 6’-6” for window  

5) Extrude the rectangle 7’ for door 
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6) Click on the create icon 

7) Select the compound object option by arrow symbol 

8) Click on the proBooleanbutton  

9) Click on the start picking button  

10) Click on the window Rectangles 

11) Object window are subtracted 

 

 
12) Click on the door rectangle. 

13) Object door are subtracted 
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4. How to applywindow in 3D modeling 

1) Click on the create option  

2) Select and click geometry icon  

3) Select by default window option 

 

 
 

4) Appear an object type option dialog box many window types show in fig 2.13 

 
Fig 2.13 

 
 

 
5) Select sliding window option show in fig 2.14 
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fig 2.14 

 
6) Active snapping tool from main tool bar 

7) Apply sliding window on the window subtract place 

8) Set parameters of window 

9) Show In fig 2.15 

 
Fig 2.15 
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5. How to apply Door in 3D modeling 

1) Click on the create option  

2) Select and click geometry icon  

3) Select by default Door option 

 

Fig 2.16 
 
 

4) Appear an object type option dialog box many Door types show in fig 2.17 

 

 
Fig 2.17 
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5) Select Pivot Door option show in fig 2.18 

 
 

Fig 2.18 
 
  

6) Active snapping tool from main tool bar 

7) Apply pivot door on the door subtract place 

8) Set parameters of door 

9) Show In fig 2.19 
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Fig 2.19 
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Practice -2 

1.  Make a 3D Fan with 4 blades with dimension 12” in diameter  

1) Open 3d max software 

2) Draw a cylinder”dia2 ” 

3) Show in fig 3.1 

 

 
Fig 3.1 

 

4) Convert in to editable poly 

5) Show in fig 3.2 
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Fig 3.2 
 

6) Select bottom polygon 

7) Select scale option and scale down 

8) Create a shape show in fig 3.3 
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Fig3.3 
 
 

9) Draw a cylinder dia 1.5” 

10) Give height in parameters 9” 

11) Show in fig 3.4 

 

 
Fig 3.4 

 
 

12) Take a copy from top cylinder 

13) Mirror it on “z” excise 

14) Show in fig 3.5 
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Fig 3.5 
 

15) Draw a circle according to the dimension 

16) Extrude the circle from parameters 

17) According to the dimension 

18) Convert into editable poly 

19) Show in fig 3.6 
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Fig 3.6 
20) Select bottom polygon 

21) Click on inset 

22) Show in fig 3.7 

Fig 3.7 
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23) Give dimension according to the drawing 

24) Show in fig 3.8 

 

 
Fig3.8 

 
25) Then use the command of Bevel 

26) For make a Bevel shap 

27) Show in fig 3.9 

 

 
 

Fig 3.9 
 

28) Give daimension according to the drawing 

29) Show in fig 3.10 
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Fig 3.10 
 

30) Draw a line for blade of fan 

31) According to the drawing 

32) Show in fig 3.11 

 

 
Fig 3.11 

 
33) Then use Extrude command for blade 

34) And attach with circle 

35) Show in fig 3.12 
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Fig 3.12 
 
 

36) Selected the blade for copy to apply other 3 blades 

37) Attach with bottom circle 

38) Show in fig 3.13 

 

 
Fig 3.13 
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Learning Unit 3:  

Apply Material and Texture to objects 
 

 

 

Objectives 

Materials and textures are what make a model look more realistic and 

appealing.  in this learning unit you will learn about how to apply 

textures and materials to a model in 3Ds max in a simple and easy 

way, how to make them in Blender, a free, open-source 3D modeling 

program. You will also learn about edit materials and texture. The 

Material Editor provides functions to create and edit materials and 

maps to get realistic outcome. 

 

 

Learning outcomes: 

After completion of this Learning Unit you will be able to: 
 

v Create/assign specified materials and texture to 3D Model. 

v Edit materials and textures to get realistic outcome. 
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3. Apply Material and Texture to objects 

 
Materials and textures are what make a model look more realistic and appealing. you can control the 
way a 3D model looks by applying materials and images to surfaces. Materials are an asset type that 
change the way models look. They are made up of a collection of properties which determine the color, 
whether the object is matte or glossy, and whether the object is metallic or translucent. 

 

3.1. Create/assign specified materials and texture to 3D Model. 

 
In 3d studio max are available many types of dialog boxes for applying material. 

We also install material and texture from internet (online) 

 

3.1.1. Explain the importance of material 

3ds max is one of the most popular CG packages out there today. It’s used in film, TV, games, 

and architectural visualization. One of the fundamental parts of 3ds max is the Material Editor. 

With the introduction of the node-based Slate material editor in 3ds max, the traditional Material 

Editor has received a boost in importance, since it’s now part of two separate material pipelines, 

one generated the old-fashioned way, and one generated through Slate. Knowing the basics of 

3ds max materials is essential and that’s what we’ll discuss here. 

 

 

3.1.2. Demonstrate the use of material on objects in the scene  

In 3d max different material editor are available for editing material. 

But two material editor option are mostly use in 3d max  

i. Compact Material Editor:  

ii. Slate Material Editors: 

 

3.1.2.1. Material Editor  

The Material Editor provides functions to create and edit materials and maps. 

i. Main toolbar > Material Editor flyout >  (Material Editor): Compact 

ii. Main toolbar > Material Editor flyout >  (Material Editor): Slate 

iii. Keyboard > M displays the version of the Material Editor (Compact or Slate) that you last 

opened. 

iv. Default menu: Rendering menu > Material Editor > Compact Material Editor 

v. Default menu: Rendering menu > Material Editor > Slate Material Editor 

vi. Alt menu: Materials menu > Create/Edit Materials > Compact Material Editor 

vii. Alt menu: Materials menu > Create/Edit Materials > Slate Material Editor 
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Materials create greater realism in a scene. A material describes how an object reflects 

or transmits light. Material properties work hand-in-hand with light properties; shading or 

rendering combine the two, simulating how the object would look in a real-world setting. 

You apply materials to individual objects or selection sets; a single scene can contain 

many different materials. 

 

There are two interfaces to the Material Editor: 

 

· Compact Material Editor:  

If you have used 3ds Max prior to the release of 3ds Max 2011, the Compact Material 

Editor is the interface you are familiar with. It is a comparatively small dialog with quick 

previews of various materials. If you are assigning materials that have already been 

designed, the Compact Material Editor is still a convenient interface. 

The Compact Material Editor is a material editor interface that uses a smaller dialog than 

the Slate Material Editor. 

 

 

 

· Slate Material Editor: 

The Slate Material Editor is a larger dialog in which materials and maps appear as nodes 

that you can wire together to create material trees. If you are designing new materials, 

the Slate Material Editor is especially powerful, and it includes search tools to help you 

manage scenes that have a large number of materials. 
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The Slate Material Editor is a material editor interface that uses nodes and wiring to 

graphically display the structure of materials while you design and edit them. It is an 

alternative to the Compact Material Editor. 

 

 

3.1.2.2. Material/map browser  

The Material/Map Browser lets you choose a material, map, or v-ray shader. 

 

 

i.  Compact Material Editor >  (Get Material) 

ii.  Compact Material Editor > Type button 

iii.  Slate Material Editor > Material/Map Browser panel 

iv.   Material Editor (either interface) > Parameter rollout > Click a map button. 
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v. Standard menu: Rendering menu > Material/Map Browser 

vi. Standard menu: Rendering menu > Environment > Environment and Effects 

dialog > Environment panel > Common Parameters rollout > Background 

group > Environment Map button 

vii. Enhanced menu: Materials menu > Tools (Material Set) > Material/Map Browser 

Enhanced menu: Rendering menu > Environment and Effects > Environment and 

Exposure Settings > Environment and Effects dialog > Environment panel > Common 

Parameters rollout > Background group > Environment Map button. 

 

Note: In the Compact Material Editor, a modal version of the Material/Map Browser 

opens when you click the Type button or any map button. When you click  (Get 

Material), the Compact Material Editor opens a modeless version of the Browser. 

In the Slate Material Editor, the Material/Map Browser appears as a panel that by default 

is always displayed. 

 

· Interface 

 
 

 
 

The Material/Map Browser contains the following controls: 

 

 

·  Material/Map Browser Options button 

Click to display the Material/Map Browser Options menu. 

 

i. Search by Name 
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Enter text in this field to search for materials and maps whose name begins with the 

characters you type. The search is not case-sensitive. 

 

 

Found materials and maps appear in a list below the search field. 

 
ii. Material/Map List 

The main part of the Material/Map Browser dialog is a scrollable list of materials and 

maps. This list is organized into groups that you can expand or collapse. 

Most of the Material/Map Browser interface is simply a list of materials, maps, and 

controllers, organized by libraries and groups. Each library and group have a title bar with 

an open/close (+/-) icon that you can use to expand or contract the list. Groups can have 

subgroups with title bars of their own, and some of these subgroups can have further 

subgroups. 

In the modal version of the Browser, if you are assigning a material type, then only 

materials appear, and if you are assigning a map, then only maps appear. 

Important: By default, the Material/Map Browser displays only materials and maps that 

are compatible with the active renderer. 
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The Material Explorer lets you browse and manage all the materials in a scene. 

i. Point-Of-View (POV) Viewport Label Menu > Extended Viewports > Material Explorer 

ii. Standard menu: Rendering menu > Material Explorer 

iii. Enhanced menu: Materials menu > Tools (Material Set) > Material Explorer 

Note: While the Material Editor lets you set the properties of individual materials, it is 

limited in the number of materials it can display at any one time. With the Material 

Explorer, you can browse all the materials in a scene, see the objects to which a material 

is applied, change material assignment, and manage materials in other ways. 

 

 

 

 

The Material Explorer interface has two panels: the upper Scene panel and the lower 

Material panel. The Scene panel is similar to the Scene Explorer, in that it lets you 

browse and manage all the materials in the scene, while the Material panel lets you 

browse and manage the components of a single material. 

 

 
3.1.2.3. Material explorer 
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3.1.2.4. Types of Materials. 

Materials create greater realism in a scene. A material describes how an object reflects 

or transmits light. You assign materials to individual objects or selection sets; a single 

scene can contain many different materials. Different materials have different uses. 

 

i. Material/Map Browser > Materials group. 

ii.  Scene Materials group, library groups, and custom groups 

 

· Procedures 
To get a material, do one of the following: 

 

i. In the Slate Material Editor, locate the material in the Browser panel, and drag it to the 

active View.-OR- 

ii. On the Compact Material Editor  toolbar, click  (Get Material). 3ds Max opens 

the Material/Map Browser. Double-click a material type or drag the material to a sample 

slot, then close the Browser. 

 

· To change a material type in the Compact Material Editor: 

i. At the level of a material, click the Type button below the Material Editor toolbar. 

ii. 3ds Max opens a modal Material/Map Browser. If you were at a material when you 

clicked Type, the Browser lists only materials (if you were at a map, it lists only maps). 

iii. Choose a material from the list, and then click OK. 

iv. If you choose a compound material, 3ds Max opens a Replace Material dialog. This 

dialog lets you choose whether to keep or discard the original material. 

v. The Material Editor now displays controls for the new material. 

 

 

· SuperSampling Rollout 

The SuperSampling rollout is used by the Architectural, Raytraced, Standard, and Ink ‘n 

Paint materials. It lets you choose a supersampling method. Supersampling performs an 

additional antialiasing pass on the material. This requires more time but can improve 

image quality. Supersampling is especially helpful when you need to render very smooth 

specular highlights, subtle bump maps, or high resolutions. 
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The mental ray Connection rollout is available for all types of materials except the 

Multi/Sub-Object material and most of the mental ray materials themselves (for which it 

would be redundant). With this rollout you can add mental ray shading to 

conventional 3ds Max materials. These effects are visible only when you use the mental 

ray renderer. 

 

ii. DirectX Manager Rollout (Legacy Direct3D Viewports) 

Lets you select a DirectX viewport shader for viewing Direct3D hardware shaders. 

 
iii. mental ray Materials 

3ds Max comes with several materials created specifically for use with the mental ray 

renderer. These materials are visible in the Material/Map Browser when mental ray or 

the Quicksilver hardware renderer is the active renderer. 

 
iv. MetaSL Material 

The Map to Material Conversion material converts a MetaSL shader tree into a material 

you can use in 3ds Max scenes. 

 
v. Standard Material and Related Materials (Non-Photometric) 

This section describes the Standard material and other materials that are not 

photometric. These materials can be suitable for games and animation, but not for 

physically accurate lighting models. 

 
vi. Photometric Materials (Non-mental ray) 

This section describes photometric materials that do not use mental ray or the mental ray 

renderer. These materials interact with light in technically accurate ways. 

 
vii. Shell Material for Texture Baking 

The Shell material is for use with texture baking. 

 
3.1.2.5. create and apply material  

You use the Material Editor to apply a material to objects. 

To apply a material to an object, do one of the following: 

 

i. If the material is selected in the Material Editor (either the Slate or the Compact interface) 

and the object is selected in the scene, click Assign Material to Selection. 

ii. In the Slate Material Editor, drag from the material node’s output socket into a viewport, 

and drop the wire over the object. 

iii. Drag a material from a library in the Material/Map Browser and drop it on the object. 

 

i. Mental ray Connection Rollout 
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Applying a material overrides any previous material assignment the object might have 

had. Once the material is applied, while the sample slot is active, the material is "hot" and 

changes you make to it affect the object automatically. The page "Material and Map 

Nodes in the Active View" has a section that describes "Hot and Cool Materials." 

 

The Undo command works for material assignment. 

 

You can apply only one material to an object. To overcome this restriction, use a 

Multi/Sub-Object material. This is a container for various sub-materials that correspond to 

specified sub-objects such as different faces in a mesh, NURBS surfaces in a NURBS 

model, and so on. 

 

You can apply the same material to multiple objects in the scene. 

 

· Workflow Outline 

In general, when you create a new material and apply it to an object, you follow these 

steps: 

 

i. Choose the renderer you plan to use, and make it the active renderer. 

ii. It is a good idea to design materials with a particular renderer in mind, as the materials 

available depend on the renderer. 

iii. Choose the material type. 

iv. When you have decided on a material type, open the Slate Material Editor. 
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3.2. Edit Materials and Textures to get realistic outcomes. 

 

The Material Editor provides functions to create and edit materials, textures and maps. Materials create 

greater realism in a scene. A material describes how an object reflects or transmits light. Material 

properties work hand-in-hand with light properties; shading or rendering combine the two, simulating how 

the object would look in a real-world setting. 

 

 

3.2.1. ???? 

??????????????   

 

On the Quick Access tool barclick  (Open File), navigate to \scenes\materialsandmapping\ 

introtomaterials\ and open armycompoundmax. 

 

Note: If a dialog asks whether you want to use the scene’s Gamma and LUT settings, accept the 

scene Gamma settings, and click OK. If a dialog asks whether to use the scene’s units, accept 

the scene units, and click OK. 

 

Except for the vehicles, the jeeps and helicopter, this scene contains no materials. The buildings 

and terrain have a featureless, plastic look to them that is typical of newly created geometry 

in 3ds Max. 
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The field headquarters before you apply materials 

You’ll begin by adding textures to the utility containers in the fenced area at the rear of the 

compound. 

 

 

· Isolate the utility containers: 

On the main toolbar, open the Named Selection Sets drop-down list, and choose 

the Utilities selection set. 

 

 
 

i. 3D Max selects the various containers. 

ii. Right-click the viewport to display the quad menu, and choose Isolate Selection. 

iii. This command is in the upper-right, Display quadrant. 
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iv. 3D Max displays the utility containers in the center of the viewport, and hides the other 

scene geometry. 

 

v. Use  (Orbit) to adjust the view so you can see all five containers clearly. 

 
 

vi. The isolated set of containers 

vii. Now you’re ready to begin creating materials for these objects. 

 

· Apply a basic material to the oil tanks: 

 

i. Activate  (Select Object). 

ii. Click an empty area of the viewport to deselect the Utilities set, and then 

click OilTank01 (the front cylindrical object on the right) to select it. 

iii. Ctrl+click Oil Tank02 and OilTank03 to select them as well. 

iv. On the main toolbar, click  (Material Editor) to open the Slate Material Editor. 
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Tip: If this is the first time you are using the Slate Material Editor, you might need to 

resize it so you can easily see all three of the columns in its interface. 

Also, to see changes in the viewport, it will help to minimize the Slate Material Editor 

while you work, and then restore it when you need to work on materials some more. 

The Material Editor is a workbench for creating, adjusting, managing, and applying 

materials to objects. The main portions of its interface are: 

i. On the left, a Material/Map Browser panel where you can choose material and map types 

(or ready-made materials) to add to the scene. 

ii. In the middle, a View panel where materials and maps appear as nodes that you can wire 

together. 

iii. On the lower right, a Parameter Editor where you can edit the material and map controls. 

Tip: If the Compact Material Editor opens instead, then on the Material Editor menu bar, 

choose Modes  Slate Material Editor. The Compact Material Editor has a smaller 

window, with conspicuous sample slots near the top of its interface. 

iv. On the Material/Map Browser panel at the left, locate Materials  Standard Standard, 

then drag the Standard entry from the Browser and drop it in the active View (the large 

panel labeled View1 in the center of the Editor). 
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A node for the Standard material appears in the active View. 
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i. Double-click the Standard material node to display parameters for the material in the 

Parameter Editor on the right side of the Slate Material Editor. 

ii. In the material Name field, near the top of the Parameter Editor, enter Oil Tanks as the 

material name. 

 

 

 

Note: That as you enter the name in the Name field, the name in the title bar of the node 

also updates. 

It is good to get in the habit of naming a material as soon as you create it. In a complex 

scene, intelligible material names are useful. 

 

iii. On the Blinn Basic Parameters rollout, below the Name field, click the color swatch that is 

labeled Diffuse. 

iv. 3ds Max opens a Color Selector dialog. 

v. Use the Red/Green/Blue controls on the Color Selector to choose a yellow color. Set Red 

= 200, Green = 200, and Blue = 0. 
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vi. The diffuse color of a material is the color that appears under diffuse, or scattered, light. It 

is what we usually think of as “the” color of a material, and what you will set first, when 

you create a basic material such as this one. 

vii. Click OK to close the Color Selector. 

viii. On the Slate Material Editor toolbar, click  (Assign Material to Selection). 

ix. In the viewport, the oil canisters turn yellow. 

x. Look at the material preview in the title bar: It now has angled corners. Double-click the 

preview to make it larger so you can get a better look. 

 

 

 

Note: Angled corners on a material preview mean that the material has been applied to 

at least one object in the scene. When the angled corners are solid white, as they are in 

this case, the material is said to be hot. When you make changes to a hot material, the 

scene changes immediately, and usually the viewport display shows the material 

changes you have made. 
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You will take advantage of adjusting a “Hot” material in the next set of steps. 

Make the oil tanks shiny: 

Make sure that the three oil tanks are still selected, and that the Oil Tanks material is still 

active. 

i. On the Blinn Basic Parameters rollout, in the Specular Highlights group, change the value 

of Specular Level to 90. 

ii. Bright highlights appear on both the sphere in the preview, and the oil tanks in the 

viewport. 

iii. Also, in the Specular Highlights group, change the Glossiness value to 32. 

 

 

 

 

Preview with the oil tank material 

 
Specular highlight controls with Glossiness = 32 

 

As you can see the preview and in the graph to the right of the Specular Highlight and 

Glossiness controls, the highlight is now narrower.  

 

Specular Level controls how bright highlights are, while Glossiness controls highlight 

width. In general, shinier materials have smaller highlights. 

You have used basic material controls, Diffuse color, Specular Level, and Glossiness, to 

create a simple material that has the appearance of a moderately shiny paint. This 

completes the material for the oil tanks. 
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· The oil tanks with their material 

Apply a texture map to the ammunition canister: 

For the ammunition canister, you will use a bitmap. Bitmaps are a versatile way to add 

visual detail to scenes, and we use them extensively in this scene. When a bitmap is 

used to provide an object’s color, it is also known as a texture map. The texture map you 

apply to the canister shows a section of metal plating with a “checkered” pattern. 
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Texture map for the ammunition canister: 

i. In the Slate Material Editor  active View, move the Oil Tanks node to one side. 

ii. Drag another Standard material node into the active View. Double-click the node to 

display the material parameters, then in the Name field, change the name of the material 

to Canister. 

iii. In the Slate Material Editor  Material/Map Browser panel, at the left, locate Maps 

Standard  Bitmap, and drag this map type into the active View. 

iv. 3ds Max opens a file dialog. 

v. In the file dialog, click to highlight the file metals.checker.plate.jpg (it is in the project 

folder \sceneassets\images\, like all the maps for the tutorials), and then click Open. 

vi. 3ds Max adds this Bitmap node to the active view. 

 

 

 

vii. Drag from the Bitmap node’s output socket (the circular control at the right of the node). 

When you drag, 3ds Max creates a wire. 
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viii. Drop the wire on the input socket for the Canister node’s Diffuse Color component. 

ix. The Bitmap is now wired to the material. 
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· Click the new Bitmap node to highlight it. 

On the Slate Material Editor toolbar, click  (Show Shaded Material In Viewport) to 

turn it on. (If you use a legacy viewport driver, this button's tooltip reads, "Show Standard 

Map In Viewport.") 

A red diagonal shape appears in the Bitmap title bar, to indicate that Show Material is 

active. 

 

i. Click the Canister node to highlight it again. 

ii. Move the Slate Material Editor window so you can see both the objects in the viewport, 

and the Canister node in the active View. Make sure that none of the utility objects is 

selected, then drag from the output socket of the Canister node (the output socket is the 

round control at the right of the node), drag to the viewport, and then release the mouse 

over the blue canister in the middle of the group. 

 

 

· Dragging from the output socket of the Canister material 

 

3ds Max applies the Canister material to the ammunition canister. 

i. Dragging and dropping from the output socket of a material node is an alternative to 

using  (Assign Material to Selection). 
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ii. Adjust the metal plate mapping: 

 

iii. If you  zoom in, you can see that the mapping is not as good as it could be. The top 

and sides of the canister look all right, but there is streaking where the top of the canister 

has beveled faces. 

 

 
iv. Streaks in the texture when using the default mapping 

v. To fix this, you use a modifier called UVW Map. 

 

vi.  Select the canister object, which is named Ammo, and go to the  Modify 

panel. 

vii. Open the drop-down Modifier list, and choose UVW Map from the list. 

Tip: Once you open the list, you can press U a couple times until the list highlights UVW 

Map, and then press Enter. 

· Parameters of UVW Map: 
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In the Parameters rollout  Mapping group, choose Box. 

The radio buttons at the top of the Mapping group (Planar, Cylindrical, Spherical, and so 

on) tell the UVW Map modifier how to project the map onto the object. Box mapping 

projects the map from all six sides, so the texture display is more uniform. 

 

i. Also, in the Mapping group, set Length = Width = Height = 2.0m. 

ii. Now the mapping is uniform and looks good from any angle. 

 
 

The texture corrected using UVW Map: 

i. Clean up the Slate Material Editor interface: 
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ii. In the Slate Material Editor  active View, click a node to select it, then press Ctrl+Ato 

select all nodes in the View. 

iii. Press Delete. 

Note: Deleting nodes from the active View simply cleans up the View for further work. It 

does not remove the materials from the scene: You can still see the materials you 

created in the Material/Map Browser  Scene Materials group. 

 

 
 

 

If you need to edit a material again, you can drag it from this group and into the View as 

an instance. 

Note: You also have the option of maintaining multiple Views of the materials for your 

scene. See the 3D Max help for more details. 

· Apply a 3D material to the generators: 

Finally, for the generators, you will use a 3D procedural map. A bitmap is simply a digital 

image such as a scan or a photograph. A 3D map, on the other hand, is generated 

by 3ds Max. 

 

i.  Select Generator01 and Generator02, the large boxy objects to the left. 

ii. In the Slate Material Editor, drag another Standard material node into the active View. 

Double-click the node, then name the material Camouflage. 

iii. Drag a Noise map from the Material/Map Browser panel into the active view, and wire it 

to the Camouflage material’s Diffuse Color component. 

iv. Double-click the Noise node to display its parameters. On the Noise Parameters rollout, 

click the color swatch labeled Color #1. 

v. 3ds Max opens a Color Selector. 

vi. Change Color #1 to a dark green: Red = 0, Green = 175, Blue = 0. 

vii. Click the color swatch labeled Color #2. On the Color Selector, change Color #2 to a tan: 

Red = 200, Green = 155, Blue = 0. 

viii. Click OK to close the Color Selector. 

ix. Click the Camouflage material node again to make it active. 

x. Click  (Assign Material To Selection), and then click  (Show Shaded Material In 

Viewport) to turn it on. (If you use a legacy viewport driver, this button's tooltip reads, 

"Show Standard Map In Viewport.") 
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xi. The map appears in the viewport, but the camouflage pattern isn’t very apparent. 

xii. On the Noise Parameters rollout, change the Noise Threshold values. Set High 

= 0.51and Low = 0.49. In addition, change the Size value to 18.0. 

xiii. Now the generator casings have a recognizable camouflage pattern. A bonus of the 

procedurally generated 3D Noise texture, is that the pattern is not quite the same on 

either generator. (This effect is more apparent when you render the scene: In viewports, 

both generators look much the same.) 

xiv. You now have a reasonably realistic texture for all of the containers in the utilities area of 

the compound. 

 
 

· Utility containers with their textures 

View the entire scene again: 

 

i. On the status bar, near the bottom of the 3ds Max window, click to turn off (Isolate 

Selection Toggle). 

ii. The viewport shows the entire scene once again. 

 

· Apply a texture map to the terrain: 

For the last step in this lesson, you will apply a texture to the terrain beneath and 

surrounding the compound. 
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Terrain texture for the army compound 

 

i. In the Slate Material Editor, drag another Standard material node into the active View. 

Double-click the node to display the material parameters, then in the Name field, change 

the name of the material to Terrain. 

ii. In the Slate Material Editor  Material/Map Browser panel, at the left, locate Maps 

Standard  Bitmap, and drag this map type into the active View. 

iii. 3ds Max opens a file dialog. 

iv. In the file dialog, choose terrain.jpg, and then click Open. 

v. Wire the new terrain texture to the Terrain material node’s Diffuse Color component. 

vi. Click the new Bitmap node to make it active, and on the Slate Material Editor toolbar, 

click  (Show Shaded Material In Viewport) to turn it on. 

vii. Drag from the Terrain material node’s output slot, and in a viewport, release the mouse 

over the Ground object. 

viii. The Ground object turns brown, but it doesn’t show the texture map. This is a sign that 

the object doesn’t have mapping coordinates. 

ix. Primitive objects such as boxes and spheres have default mapping coordinates, but 

editable geometry such as Ground, which is an Editable Poly, does not. You have to 

assign mapping coordinates by applying UVW Map. 

x.  Select the Ground object, and go to the  Modify panel. 

xi. Use the Modifier List to apply a UVW Map modifier. 

xii. For the terrain, the default Planar projection works fine, and the map terrain.jpg is already 

the right size for the scene, so your work in this lesson is now complete. 
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Army compound with textured utility containers and terrain 

 

xiii. Save your work 

 

3.2.1.1. UVW Map Modifier  

By applying mapping coordinates to an object, the UVW Map modifier controls how 

mapped and procedural materials appear on the surface of an object. Mapping 

coordinates specify how bitmaps are projected onto an object. The UVW coordinate 

system is similar to the XYZ coordinate system. The U and V axes of a bitmap 

correspond to the X and Y axes. The W axis, which corresponds to the Z axis, is 

generally only used for procedural maps. A bitmap's coordinate system can be switched 

in the Material Editor to VW or WU, in which case the bitmap is rotated and projected so 

that it is perpendicular to the surface. 

 

i. Select an object. > Modify panel > Modifier List > Object-Space Modifiers > UVW Map 

ii. Standard menu: Select an object. > Modifiers menu > UV Coordinates > UVW Map 

iii. Enhanced menu: Select an object. > Modifiers menu > UVs, Maps and Materials > UVW 

Map 
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Mapping a sphere and a box. 

 

By default, primitive objects such as spheres and boxes have mapping coordinates, as 

do loft objects and NURBS surfaces. Scanned, imported, or hand-constructed polygonal 

or patch models do not have mapping coordinates until a UVW Map modifier is applied. 
 

Note: Drawings that are imported or linked from Autodesk Architectural Desktop and 

Autodesk Revit do retain the mapping coordinates that were assigned to objects by those 

products. 

If you apply a UVW Map modifier to an object with built-in mapping coordinates, the 

applied coordinates take precedence if map channel 1 in the UVW Map modifier is used. 

The Generate Mapping Coordinates option, available during the creation of primitives, 

uses map channel 1 by default. 

You use the UVW Map modifier to: 

i. Apply one of the seven types of mapping coordinates to an object on a specified map 

channel. A diffuse map on map channel 1 and a bump map on map channel 2 can have 

different mapping coordinates and can be controlled separately by using two UVW Map 

modifiers in the modifier stack 

ii. Apply one of the seven types of mapping coordinates to an object. 

iii. Transform the mapping gizmo to adjust map placement. Objects with built-in mapping 

coordinates lack a gizmo. 

iv. Apply mapping coordinates to an object with no mapping coordinates, an imported mesh, 

for example. 

v. Apply mapping at the sub-object level. 

· Procedures Interface 
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· Map Channels 

 

You can control the type of mapping coordinates and the placement of the mapping 

gizmo for each bitmap in a material that uses multiple bitmaps by assigning explicit map 

channels to the bitmaps. In the Material Editor you assign each map a different channel 

number, then you add multiple UVW Map modifiers to the object's modifier stack, each 

UVW Map modifier is set to a different map channel. To change the type of mapping or 

gizmo placement for a particular bitmap, you select one of the UVW Map modifiers in the 

modifier stack and change the parameters. You can change the name of a UVW Map 

modifier in the Edit Modifier Stack dialog to correlate the modifier to the bitmap. 
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· Transforming UVW Map Gizmos 

 

 

 

· Changing a map's location by moving the gizmo. 

The UVW Map gizmo projects mapping coordinates onto an object. You can position, 

rotate, or scale a gizmo to adjust map coordinates on an object; you can also animate the 

gizmo. Gizmo transformations remain in effect if you select a new map type. For 

example, if you scale a spherical mapping gizmo and then switch to planar mapping, then 

the planar mapping gizmo is also scaled. 

 

· Gizmo Display for Different Map Types 

For planar, spherical, cylindrical and shrink wrap maps, a short yellow line indicates the 

top of the map. The green edge of the gizmo indicates the right side of the map. On a 

spherical or cylindrical map, the green edge is the seam where the left and right edge 

meet. Gizmo must be selected in the modifier display hierarchy to display the gizmo. 
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Gizmos for different projection types 

Left to right: planar, cylindrical, box, and spherical 

 

· Effects of Transforming the UVW Map Gizmo 

Moving the gizmo changes the center of projection and affects all types of mapping. 

Rotating the gizmo changes the orientation of the map, which affects all types of 

mapping. Uniform scaling does not affect spherical or shrink-wrap mapping. Non-uniform 

scaling affects all types of mapping. 

Note: If you scale a gizmo smaller than the geometry, then a tiling effect is created, 

unless scaling has no effect on the map type in use. Tiling based on gizmo size is in 

addition to tiling values set in the Material Editor Coordinates rollout for the map or the 

UVW Map modifier tile controls. 

 

 

The size of the gizmo affects how the mapping is applied to an object. 

 

3.2.1.2. Manipulators for UVW Map 

The UVW Map modifier has graphic manipulators to help you adjust the mapping 

dimensions and tiling. To use these, turn on  (Select And Manipulate). The 

manipulators are available at the main UVW Map level in the modifier stack, and also at 

the UVW Map modifier  Gizmo level. 

Manipulators appear as edges at the sides of the gizmo; typically they display as green. If 

the mapping type and gizmo are 3D, a green cube also appears at the top of the gizmo. 
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When you move the mouse over a manipulator, the manipulator typically turns red to 

show that dragging or clicking it will have an effect. Also, a tooltip appears, showing the 

object name, the parameter, and its value. 

There are no manipulators for these mapping types: 

i. Shrink Wrap 

ii. Face 

iii. XYZ to UVW 

 

Note: When Real-World Map Size is on, gizmo manipulators appear only for the Planar 

and Box mapping types. 

 
 

Adjusting an edge manipulator for Box mapping 
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· Adjusting the height manipulator for Box mapping 

When you use the manipulator to adjust the Height, the gizmo remains centered on the 

Length/Width plane, so the Height adjustment scales the mapping. 

 

i. Tile Controls 

Use the UVW Tile controls if you want a map to repeat. Tiled maps are useful for bricks 

on a wall, or tiles on a floor. Rather than creating one large map, seamless maps can be 

tiled to surface a large area without visible seams, to give the illusion of a large map. 

 

Tiling in the UVW Map modifier affects only the objects that use this modifier. Tiling a 

map in the Material Editor affects tiling on all the objects that use the material. 

 

Material and UVW Map tiling are multiplied. For example, if a map in the Material Editor 

has a tile value of 2 on one axis, and a UVW Map modifier has a tiling value of 3 on the 

same axis, then the result is a tiling value of 6. 

 

ii. Objects with No Mapping Coordinates 

If you render an object that doesn't have mapping coordinates or a UVW Map modifier, 

and the object uses a material with 2D bitmaps or 3D procedural maps that use explicit 

map channels, then a Missing Map Coordinates alert is displayed. The alert lists both the 

name of the object and the UVW channels or Vertex Color channels that are missing the 

coordinates. For example: (UVW 2): Torus01. 

 

iii. Mapping Selection Sets or Grouped Objects 

You can apply one UVW Map modifier to a selection of objects. One large mapping 

gizmo will encompass the entire selection unless the Use Pivot Points option is turned on 

in the modifiers rollout before applying the UVW Map modifier. If the Use Pivot Points 

option is used then each object is encompassed with its own mapping gizmo. 

If any of the objects in the selection has had its pivot point shifted in the Hierarchy 

Pivot panel, and you use the Use Pivot Points option with the UVW Map modifier, then 

the mapping gizmos are centered to the pivot points rather than the object center and the 

mapping may be tricky to position the way you want. 

 

· Procedures 

To apply the UVW Map modifier: 

 

i. Assign a mapped material to an object. 

ii. On the Modify panel  Modifier List, choose UVW Map. 

iii. Adjust the mapping parameters. 

iv. By default, the UVW Map modifier uses planar mapping on map channel 1. You can 

change the type of mapping and the map channel to suit your needs. There are seven 
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types of mapping coordinates, ninety-nine map channels, tiling controls, and controls to 

size and orient the mapping gizmo in the UVW Map modifier. 

v. Note: If a UVW Map modifier is applied to multiple objects, the UVW Map gizmo is 

defined by the selection, and the mapping that results is applied to all the objects. 

vi. To use multiple UVW channels in the same object: 

vii. Assign Map channel 1 to an object. You can do this by either turning on Generate 

Mapping Coordinates in the Parameters rollout of any primitive, or by assigning a UVW 

Map modifier with channel 1 chosen. 

viii. Generate Mapping Coordinates uses map channel 1 by default. 

ix. Assign a UVW Map modifier (or a second one, if you're using the first to assign channel 

1). Choose channel 2 for this modifier. 

x. Both coordinate channels are now assigned to the geometry. The next step is to assign a 

mapped material that uses both channels. 

xi. Create a material with two maps. You can do this using a Composite map, or a Blend 

material with two maps, or you can have one map assigned to Diffuse and another 

assigned to Bump. Perhaps the easiest way to see the effect is to composite two maps, 

with the second map containing an alpha channel. 

xii. Go to the level of one of the maps and, in the Mapping list, choose Explicit Map Channel 

2. 

xiii. The other map is already assigned channel 1 by default. 

xiv. Assign the mapped material to the object. 

xv. You can switch between viewing the maps in the viewport using the Show Map In 

Viewport control in the Material Editor. You can adjust the mapping of channel 2 without 

altering the mapping of channel 1 if you've assigned two UVW Map modifiers. Render the 

scene to see the effect. 

xvi. Example: To use the XYZ to UVW option: 

xvii. The XYZ to UVW option lets you make a 3D procedural texture, like Cellular, follow the 

animated surface of an object. If the object stretches, so does the 3D procedural texture. 

xviii. In the Top viewport, create a box. 

xix. Create a material with a Cellular diffuse map. 

xx. In the Material Editor, on the Coordinates rollout of the Cellular map, open the Source 

drop-down list, and choose Explicit Map Channel. 

xxi. On the Coordinates rollout, the Map Channel parameter activates, leave the value at 1. 

xxii. Assign the material to the box. 

xxiii. On the Modify panel  Modifier List, choose UVW Map. 

xxiv. On the UVW Map modifier, turn on XYZ to UVW. 

xxv. By default, the Map Channel value is 1. 

xxvi. Render the Front viewport. 

xxvii. The cellular pattern renders normally on the surface of the box. 
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xxviii. Right-click over the object and choose Convert To:  Convert to Editable Mesh from the 

Transform (lower-right) quadrant of the quad menu. 

xxix. The box is converted to an editable mesh. 

xxx. On the Modify panel  Selection rollout, click Vertex to turn it on. 

xxxi. In the Front viewport, select the top vertices of the box, and move them up. 

xxxii. Render the Front viewport again. 

xxxiii. The cellular pattern stretches with the box. This effect is enabled by the XYZ to UVW 

option. To see the difference, we will change the Source option in the Coordinates rollout 

in the Material Editor. 

xxxiv. In the Material Editor, locate the diffuse Cellular material. 

xxxv. On the Coordinates rollout of the Cellular diffuse map, open the Source drop-down list 

and choose Object XYZ. 

xxxvi. Render the Front viewport. 

xxxvii. The cellular pattern is no longer stretched. 

xxxviii. To transform the UVW Map gizmo: 

xxxix. On the Modify panel, choose the UVW Mapping modifier in the stack display. 

xl. In the stack display, choose the Gizmo sub-object level. 

xli. The gizmo changes to a yellow color, with one green edge. 

xlii. The green edge indicates the right edge of the texture. 

xliii. Move, scale, or rotate the gizmo in the viewports, or use the Length and Width controls in 

the UVW Map modifier. 

xliv. Transforming the map gizmo shifts the bitmap, allowing you to orient and move the map 

on the object's surface. 

xlv. To use manipulators to control the width and length: 

xlvi. On the Modify panel, choose the UVW Map modifier in the stack display. 

xlvii. You can also be at the Gizmo level of the modifier. 

xlviii. On the main toolbar, click to turn on Select And Manipulate. 

xlix. Green edges appear along the sides of the UVW Map modifier's gizmo. An edge turns 

red when you move the mouse over it. 

l. Drag an edge of the gizmo to adjust the width or length. 

li. A tooltip shows the new width or length value. 

lii. To use manipulators to control vertical scale: 

liii. On the Modify panel, choose the UVW Map modifier in the stack display. 

liv. You can also be at the Gizmo level of the modifier. 

lv. On the main toolbar, click to turn on Select And Manipulate. 

lvi. For 3D mapping types, a green cube appears at the top of the UVW Map modifier's 

gizmo. The cube turns red when you move the mouse over it. 
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lvii. Drag the cube to adjust the height of the gizmo. 

lviii. A tooltip shows the new tiling value in the vertical dimension. 

 

3.2.1.3. Interface 

· Modifier Stack 

Gizmo sub-object level: 

Enables gizmo transformations. At this sub-object level you can move, scale, and rotate 

the gizmo in the viewports to position the mapping. 

Tip: To see the map move on the object surface as you transform the gizmo, enable one 

of the Show Map In Viewport options. 

 

· Parameters rollout 
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· Mapping group 

Determines the type of mapping coordinates used. Different kinds of mapping are 

distinguished by how the map is geometrically projected onto the object and how the 

projection interacts with the object's surfaces. 

Note: When Real-World Map Size is on, only the Planar, Cylindrical, Spherical, and Box 

mapping types are available. Similarly, if one of the other options (Shrink Wrap, Face, or 

XYZ to UVW) is active, Real-World Map Size is unavailable. 

 

· Planar 

Projects the map from a single plane flat against the object, somewhat like projecting a 

slide. 

Planar projection is useful when only one side of an object needs to be mapped. It is also 

useful for obliquely mapping multiple sides, and for mapping two sides of a symmetrical 

object. 

 

 

Planar map projection 

 
 

 

 

· Cylindrical 

Projects the map from a cylinder, wrapping it around an object. Seams where the edges 

of the bitmap meet are visible unless a seamless map is used. Cylindrical projection is 

useful for objects that are roughly cylindrical in shape. 
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Cylindrical map projection 

· Cap 

Applies planar mapping coordinates to the caps of the cylinder. 

Note: If the ends of the object geometry are not at right angles to the sides, the Cap 

projection bleeds onto the sides of the object. 

 

· Spherical 

Surrounds the object by projecting the map from a sphere. You see a seam and mapping 

singularities at the top and bottom of the sphere where the bitmap edges meet at the 

sphere's poles. Spherical mapping is useful for objects that are roughly spherical in 

shape. 

 

 

 

Spherical map projection 
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· Shrink Wrap 

Uses spherical mapping, but truncates the corners of the map and joins them all at a 

single pole, creating only one singularity. Shrink-wrap mapping is useful when you want 

to hide the mapping singularity. 

 

Shrink-wrap projection 

 

· Box 

Projects the map from the six sides of a box. Each side projects as a planar map, and the 

effect on the surface depends on the surface normal. Each face is mapped from the 

closest box surface whose normal most closely parallels its own normal. 

 

 

 
 

 

Box projection (shown on a box and on a sphere) 
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· Face 

Applies a copy of the map to every face of an object. Pairs of faces sharing a hidden 

edge are mapped with the full rectangular map. Single faces with no hidden edge are 

mapped with a triangular portion of the map. 

 

Face projection 

 

· XYZ to UVW 

Maps 3D procedural coordinates to UVW coordinates. This "sticks" the procedural texture 

to the surface. If the surface stretches, so does the 3D procedural map. Use this option 

with procedural textures, like Cellular, on objects with animated topologies. 

For more information on how to use this option, see Example: To use the XYZ to UVW 

option:. 

Tip: In the Material Editor's Coordinates rollout for the map, set Source to Explicit Map 

Channel. Use the same map channel in the material and UVW Map modifier. 

 

 
 

A sphere with a 3D procedural texture is copied, and the copies are stretched. 
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Right: Using XYZ to UVW on the object enables the 3D procedural texture to stick and 

stretch with the surface. 

 

· Length, Width, Height 

Specify the dimensions of the UVW Map gizmo. The default scale of the mapping icon is 

defined by the largest dimension of the object when you apply the modifier. You can 

animate the projection at the gizmo level. Note the following facts about these spinners: 

 

i. The dimensions are based on a bounding box of the gizmo. 

ii. The Height dimension is unavailable for the Planar gizmo: It does not have depth. 

Likewise, the dimensions for Cylindrical, Spherical, and Shrink Wrap mapping all display 

the dimensions of their bounding box and not their radiuses. No dimensions are available 

for the Face map: Each face on the geometry contains the entire map. 

iii. The three dimensions are set to 1 or 2, depending on map type and dimensions, when 

you load files created in Autodesk VIZ or earlier versions of 3ds Max. (This maintains 

compatibility with files from previous releases, in which gizmos were scaled non-uniformly 

to adjust their dimensions.). 

iv. The dimensions essentially become scale factors rather than measurements. You can 

reset the values to dimensions by clicking the Fit or Reset buttons, which will lose the 

original non-uniform scaling. 

 

· U Tile, V Tile, W Tile 

Let you specify the dimensions of the UVW map, for tiling the image. These are floating-

point values, which you can animate to displace the map's tiling over time. 

 

· Flip 

Reverses the image about the given axis. 

 

· Real-World Map Size 

 

When on, uses real-world mapping for texture-mapped materials that are applied to the 

object. The scaling values are controlled by the Use Real-World Scale settings found on 

the applied material's Coordinates rollout. (Both Real-World Map Size and Use Real-

World Scale should be either off or on at the same time.) Default = off. 

When on, the Length, Width, Height and Tiling spinners are unavailable. 

 

· Channel group 

Each object can have up to 99 different UVW mapping coordinate channels; one per 

modifier. The default mapping channel (from the Generate Mapping Coordinates toggle in 

the object’s creation parameters) is always channel 1. The UVW Map modifier can 
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specify coordinates for any channel. This lets you have many different sets of coordinates 

on the same face simultaneously. 

Attention: The UVW Map modifier works on only one map channel at a time. When you 

change channels, 3ds Max copies the current edits to the new channel without alerting 

you. To apply different UVW mapping in different channels, use multiple modifiers 

(Unwrap UVW or UVW Map). 

If you already have edits in that channel from another modifier, those edits could be 

overwritten. To ensure preservation of your edits, save them before changing channels 

and then reload the saved edits as necessary. 

· Map Channel 

Sets the map channel. The UVW Map modifier defaults to channel 1, so mapping 

behaves in the default fashion unless you explicitly change to another channel. 

Default=1. Range=1 to 99 

If you specify a different channel, make sure any maps in the object’s material that should 

use that mapping are also set to that channel. 

You can use multiple UVW Map modifiers in the modifier stack, each one controlling the 

mapping coordinates of different maps in a material. 

The map channel setting is available in various places in 3ds Max, as follows: 

 

i. Generate Mapping Coords  

This checkbox, present in the creation parameters of most objects, assigns map channel 

1 when on. 

ii. UVW Map, UVW Xform, and Unwrap UVWs modifiers 

These modifiers let you set the map channel to 1 through 99, thus specifying which UVW 

coordinates the modifier uses. The modifier stack can pass these channels 

simultaneously for any face. 

iii. Material Editor Channel Assignment 

You assign the channel to be used by a map on the Coordinates rollout at the map level 

in the Material Editor. The Explicit Map Channel option must be active. 

iv. NURBS Surface Objects and Sub-Objects 

Let you specify which map channel the surface uses. 

 

· Vertex Color Channel 

Define the channel as a vertex color channel by choosing this option. Be sure to match 

any material mapping in the coordinates rollout to be Vertex Color as well, or by using the 

Assign Vertex Colors utility. 

· Alignment group 

X/Y/Z Select one of these to flip the alignment of the mapping gizmo. Each specifies 

which axis of the gizmo is aligned with the local Z axis of the object. 
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Note: These options aren't the same as the Flip checkboxes beside the U/V/W Tile 

spinners. The Alignment option buttons actually flip the gizmo orientation, while the Flip 

checkboxes flip an assigned map's orientation. 

 

3.2.2. Manipulate 

When on, a gizmo appears on the object that lets you change parameters in the viewport. When 

Real-World Map Size is on, manipulate is available only with the Planar and Box mapping types. 

For more information, see Manipulators for UVW Map. 

 

 
 
 

 

Tip: Turn on snapping to adjust the mapping precisely. 

i. Fit 

Fits the gizmo to the extents of the object and centers it so that it's locked to the object's 
extents. Unavailable when Real-World Map Size is on. 

ii. Center 

Moves the gizmo so that its center coincides with the center of the object. 

iii. Bitmap Fit 

Displays the standard bitmap file browser so that you can pick an image. Unavailable 

when Real-World Map Size is on. 

Note: For planar mappings, the map icon is set to the aspect ratio of the image. For 

cylindrical mapping, the height (rather than the radius of the gizmo) is scaled to match the 

bitmap. For best results, first use the Fit button to match the radius of the object and 

gizmo, and then use Bitmap Fit. 
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· Normal Align 

Click and drag on the surface of the object to which the modifier is applied. The origin of 

the gizmo is placed at the point on the surface where the mouse is pointing; the XY plane 

of the gizmo is aligned to the face. The X axis of the gizmo lies in the object's XY plane. 

Normal Align respects smoothing groups and uses the interpolated normal based on face 

smoothing. As a result, you can orient the mapping icon to any part of the surface, rather 

than having it "snap" to face normal. 

 

· View Align 

Reorients the mapping gizmo to face the active viewport. The size of the icon is 

unchanged. 

 

i. Region Fit 

Activates a mode in which you can drag in the viewports to define the region of the 

mapping gizmo. The orientation of the gizmo is not affected. Unavailable when Real-

World Map Size is on. 

ii. Reset 

Deletes the current controller controlling the gizmo and plugs in a new one initialized 

using the Fit function. Any animation to the gizmo is lost. As with all the alignment 

options, you can cancel the reset operation by clicking Undo. 

iii. Acquire 

Effectively copies the UVW coordinates from other objects When you pick an object from 

which you want to acquire UVWs, a dialog prompts you whether the acquire should be 

done in an absolute or relative fashion. 

If you choose Absolute, the acquired mapping gizmo is positioned exactly on top of the 

mapping gizmo you pick. If you choose Relative, the acquired mapping gizmo is 

positioned over the selected object. 

 

· Display group 

 
 

 

This setting determines whether and how mapping discontinuities, also known as seams, 

appear in the viewports. The seams appear only when the Gizmo sub-object level is 

active. 

Tip: The default seam color is green; to change it, go to Customize menu  Customize 

User Interface  Colors tab, and then from the Elements drop-down list, choose UVW 

Map. 
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The options are: 

i. Show No Seams 

Mapping boundaries don't appear in the viewports. This is the default choice. 

ii. Thin Seam Display 

Displays mapping boundaries on object surfaces in the viewports with relatively thin lines. 

The line thickness remains constant as you zoom the view in and out. 

iii. Thick Seam Display 

Displays mapping boundaries on object surfaces in the viewports with relatively thick 

lines. The line thickness increases when you zoom the view in and decreases when you 

zoom out. 
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Practic-1 

 Apply material to last developed 3d LED lamp in LU 1- practice-2 as shown in Figure-2. 

 
1) Open file 3d led lamp from file path 

2) Show in fig 1.1 

 

  

 

 

 

 

 

 Fig 1.1 

 

3) Select base of led lamp 

4) Open material editor with short key “M” 

5) Select material from material list 

6) Make the color black 

7) Apply on the LED base 

 

 

8) Select rod of LED lamp 

9) Open material editor with short key “M” 

10) Select material from material list 

11) Make the color silver 

12) Apply on the LED Rod 

13) Show fig in  
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14) Select Dome of led lamp 

15) Open material editor with short key “M” 

16) Select material from material list 

17) Make the color gold 

18) Apply on the LED dome 
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Practic-02 

Apply material to the model (previously create in lu-2/ practice -1) by using 3ds max 

 
1) Open 3D file from file path 

2) Show in fig 2.1 

 

Fig 2.1 
 

 
3) Select walls from object 

4) Open material editor with short key “M” 

5) Select material from material list 

6) Make the material for brick 

7) from library 

8) Apply on the walls 

9) Show in step-1 

 

 
step-1 

 
 

10) Select walls from object  

11) Open material editor with short key “M” 
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12) Select material from material list 

13) Make the material for brick from library 

14) Apply on the walls 

15) Show in step-2 

 

step-02 
 
 

16) Select UVW Mapping from modifier command panel  

17) Mapping on wall brick texture 

18) show in step -3 

 
 

step-3 
 

19) If we want to apply defrent material on the wall then convert it into editable poly for select difrnet sufaces 
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20) convert walls in editable poly 

21) Select polygon icon for apply deferent materials 

22) show in step-4  

 
 

step -4 
 

23) Apply deferent material on red surface 

24) Example apply white pant on red surface 

25) show in step -5 

 
 

step-5 
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How to make window Frame  

There are many types of frame like 

 

1) Aluminum frame 

2) Wooden frame  

3) Rot iron frame 

 
 

Here we use rot iron frame witch color is black 

1) For making glass open  material editor with short key “M” 

2) Select one ball from "M"  

3) Diffuse color should be black 

4) show in step 09   

 
step -9 

 
 

5) Select reflection 

6) Show in step 10  
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step-10 

 
 

7) Set refl. glossiness value 

8) Value should be 0.7 to 0.85 

9) Subdivs value should be 20 

10) Fainal frame of window 

 

 

11) Apply glass material on window 

12) For making glass open material editor with short key “M” 

13) Select one ball from "M"  

14) Diffuse color should be black 

15) show in step 06   
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step-06 
 
 

16) Select reflection  

17) Reflection will be full  

18) Show in step 07 

 
 
 

 
step -07 

 
 
 
 

 
19) Subdivs should be 20 

20) Show in step 07 

21) Select refraction 

22) Show in step 08 
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step-08 

 
 

23) refrection should be full 

24) Set the IQR value 

25) IQR set on 6 

 

 

final glass of window 
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Marge a door in House plan 

1) Select a door from file  

2) Marge it into the house plan (Marge already explain in LU-1) 

3) show in step 10 

 
 

 
step-10 
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Learning Unit 4:  

Render 3D Model 

 

Objective: 

Render is the most impotent subject .in this unit we install 
different Plug-ins like v-ray, scanline, corona. How to adjust 
camera and light also available on this unit 

 

 

Learning Outcomes: 
 

After completion of this Learning Unit you will be able to: 

 

v Assign/install render to meet specific outcomes as per 

requirement. 

v Add scene of 3D model according to specification. 

v Add light for illumination to get the requisite scene of 3D model. 

v Assign camera to execute different view of 3D model. 

v Render the 3D model to required image size or regulation & 

orientation. 
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4. Render 3D Model 

 

In render model technique we learned that how to use render model technique   

 

4.1. Assign/install render to meet specific outcomes as per requirement 

 

The Assign Renderer rollout displays which renderers are assigned to the production and Active 

Shade categories, as well as the sample slots in the Material Editor. 

 

 

 

 
 

4.1.1. Install different Plug-ins (Extensions) from “AUTODESK App Store” for 

different categories. 

Rendering tools are generally used to make parts and assemblies look more realistic. 

there are different plug ins for rendering like  

 

· V-Ray 

· Corona 

· Scaneline 

 

4.1.1.1. V-Ray Renderer for 3ds Max installation 

 

This discussion provides information on installing V-Ray for 3ds Max. 

A complete installation of V-Ray 3.6 for 3ds Max consists of: 

i. V-Ray 

ii. V-Ray RT 

iii. V-Ray Standalone 

iv. V-Ray DR Spawner 

v. V-Ray license server 

vi. V-Ray tools 

vii. V-Ray SDK 

 

· Installation of V-Ray 3.6 

V-Ray installer will automatically remove any previous installations. This will allow you to 

seamlessly upgrade from V-Ray 1.5 and V-Ray 2.0. If you experience problems, you can 
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manually uninstall the previous versions to perform a clean install. For more information 

please refer to the Uninstall V-Ray page. 

Before running the installation, make sure your Windows account has administrative 

privileges and the dongle is not plugged in. 

 

· Setting up the installation 

Run the installer. 

 

i. Upon the start of the installation, Windows may ask you for permission to run the installer 

with administrator privileges. Please confirm. 

ii. You will be presented with the V-Ray licensing agreement. Please take a moment to 

review the agreement. Click the “I agree” button to proceed. 

iii. During the next step you can choose the installation type. The available installation types 

are: 

a) Workstation: This is a full installation and includes all components as described in 

the “Installation overview” section. It will allow you to use V-Ray in 3ds Max, do 

Distributed or Network Rendering, run V-Ray RT render server, use V-Ray SDK, and 

have V-Ray license server on this machine. 

 

b) 3ds Max render slave: This installation includes V-Ray, V-Ray RT, V-Ray 

Standalone, V-Ray DR Spawner, and external V-Ray tools. This option does not 

include the local V-Ray license server application. Please choose this option if you 

plan to use this machine for Distributed or Network Rendering with V-Ray. 

 

c) Standalone render slave: This installation includes V-Ray Standalone and V-Ray 

RT render server. Please choose this option if you plan to use this machine only for 

Distributed Rendering with V-Ray Standalone and a V-Ray RT render server. 
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iv. After you choose the installation type you can click the “Customize” button and adjust the 

corresponding installation settings. If you have selected the Workstation installation, you 

will see the full list of customizable settings: 

 

a) Uninstall previous installations: Leave this checked to automatically uninstall any 

previous versions. 

 

b) Register V-Ray menus: Leave this checked to integrate V-Ray menus within the 3ds 

Max interface. 

 

c) Help us improve V-Ray:Participate in the improvement decisions for future version 

of V-Ray.  No intelligence property is violated when agreeing to participate in the 

feedback program. We do not gather scenes, assets, materials, etc. What we receive 

is user preferences on just a few key render settings and the resulting render times. 

The point of this feature is to improve V-Ray's performance and the user 

experience. This preference can be changed at any time later from the V-Ray Setup 

> V-Ray > About V-Ray > Feedback program settings. 
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d) How are you going to connect to the V-Ray license server? :Specifies whether 

the V-Ray license server will run locally or on another machine. 

If you select the option Remote V-Ray license server on the network, you 

will have to fill in the IP address of your V-Ray license server in the field 

Primary License Server. Please leave the port 30304 unchanged. 

 

e) Specify installation paths: Please check if the default folders are correct. 

Common settings for Workstation installation for 3ds Max 2018 with a remote 

license server and default paths, should look like the screenshot below: 

 

v. When ready click the “Install Now” button. 

vi. If the installer detects any applications that need to be closed, they will be listed before 

being able to continue. Please close them and click "Install Now" 
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List of running applications to close 

  

 
Installation can continue with applications closed 

  

·  Completing the installation 

Please skip the steps that are not relevant for your installation type. 

 

i. After you click the “Install Now” button, the installer will proceed to uninstall any previous 

versions and install V-Ray 3.6 on your machine. 
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Uninstalling old versions 

 
Installation new version 

ii. If the installation was successful, you will get this screen. Press the “Finish” button. 

TVET SSP does not secure copyright of these pictures
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iii.  After you press Finish, the Online License Server installation window will appear next. 

 

4.1.1.2. Corona Renderer for 3ds Max Installation Process  

 

Corona Renderer comes with an automated Universal Installer, which makes the 

installation process very easy: 

 

i. Run the Universal Installer. 

Note: If you are using User Account Control (UAC), a security prompt will open – you will 

need to confirm that the installer can continue. The security window will also tell you if the 

file you have just run is a certified, genuine copy coming directly from Chaos Czech a.s. 

(formerly Render Legion a.s.) and does not contain any harmful code.         

ii. Carefully read the EULA and select “I accept the terms and conditions”. Then click “next”. 

iii. On the “Install Type” screen you can select:                           

a) Typical  

Install Corona plugins for all software versions detected, plus the Corona Image 

Editor (GUI and Command Line versions) and the Corona Distributed Rendering 
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server. This is recommended for most users. It is the fastest, fully automated 

installation type. 

b) Custom  

Manually choose features to install, and where to install them. This is an advanced 

installation method, allowing you to choose the specific items to be installed, and 

their locations. Useful, for example, when you have different 3ds Max versions 

installed and you want to install Corona Renderer for only one of them, or if you only 

want to install certain components (such as the DR Server, Licensing Server, Corona 

Standalone, or the Corona Image Editor).     

c) Unpack files 

This unpacks all the installer files into a specified directory. Useful for advanced 

users and debugging, for example when installing the plugins manually, or if there 

were some problems during the installation, e.g. if the installer could not find any host 

application, then you can unpack the files and copy them manually. 

iv. The installer will then tell you if your hardware is capable of running the standard full–

speed version of Corona Renderer, or the legacy version. 

Note: From Corona Renderer 2 onward, the legacy version will no longer be offered, and 

you will need a CPU that supports the SSE4.1 instruction set (that is, any processor from 

within the last 10 years). Here is a list of compatible CPUs. From Corona Renderer 3 

onward, the Licensing Server and the DR Server will no longer support CPUs without the 

SSE4.1 instruction set and are now 64-bit only applications (they will not run on 32-bit 

versions of Windows). 

v. After successful installation you should see the following message: “Corona Renderer 

was successfully installed on your computer”. Any errors will be marked with a red 

font. 

 

vi. Before running 3ds Max, make sure that your computer is connected to the Internet. 

 

 

vii. Start 3ds Max, change the renderer to Corona Renderer, and run a render in any scene 

(even empty). A window will pop up prompting for activation. Follow the directions on 

screen to activate Corona Renderer. 

 

Note: if you need any help with the activation process, or if you need to use some other 

activation method, see: Activating Corona Renderer for 3ds Max. 
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4.2. Add scene of 3D modal according to specification 

 

There are many types of Adding different scene according to specifications like  

 

i. Camera  

ii. Light 

 

4.2.1. Add different Cameras to adjust scene. 

Using different cameras to adjust scene, is therefore very necessary to learn especially when 

making 3d SketchUp architectural drawings. 

 

4.2.1.1. Camera  

 

Cameras present a scene from a particular point of view. Camera objects simulate still-

image, motion picture, or video cameras in the real world.  

After you have created a camera, you can set viewports to display the camera's point of 

view. With a Camera viewport you can adjust the camera as if you were looking through 

its lens. Camera viewports can be useful for editing geometry as well as setting up a 

scene for rendering. Multiple cameras can give different views of the same scene.  

If you want to animate the point of view, you can create a camera and animate its 

position. For example, you might want to fly over a landscape or walk through a building. 

You can animate other camera parameters as well. For example, you can animate the 

camera's field of view to give the effect of zooming in on a scene.  

 
An example of a camera in a scene. 
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The result after rendering through the camera. 

There are two kinds of cameras in 3ds Max:  

i. Physical Cameras 

integrate framing the scene with exposure control and other effects that model real-world 

cameras.  

ii. Legacy Cameras have a simpler interface with fewer controls. Both physical cameras 

and legacy cameras can be either targeted or free. 

 

4.2.1.2. Physical Camera

The V-Ray Physical Camera uses real-world camera settings such as f-stop, focal length, 

and shutter speed to set up the virtual CG camera. It also makes it easier to use light 

sources with real-world illumination, such as V-Ray Light with physical units or V-Ray 

Sun and V-Ray Sky. 

Note: In 3D Max 2016, the V-Ray Physical Camera is not directly accessible through the 

menu. Instead, the new 3ds Max Physical camera type can be used. The documentation 

on the Max Physical camera can be accessed from Max's Help menu > Autodesk 3D 

Max Help, and then searching for "Physical Camera". For more details, see V-Ray 

Physical Camera in 3ds Max below. 
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· UI Paths 

Create Menu >Cameras> V-Ray >V-Ray Physical Camera 

V-Ray Toolbar >Physical Camera button 

 

 

 

· Basic Parameters 
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i. Type 

Determines the type of the camera. This mostly has an effect on the motion blur effect 

produced by the camera. 

 

ii. Still Cam 

Simulates a still photo camera with a regular shutter. 

 

iii. Cinematic Camera  

Simulates a motion-picture camera with a circular shutter. 

iv. Video Camera 

Simulates a shutter-less video camera with a CCD matrix. 

v. Targeted 

Specifies whether the camera has a target in the 3ds Max scene or not.  

vi. Film Gate (mm) 

Specifies the horizontal size of the film gate in millimeters. Note that this setting takes into 

account the system units configuration to produce the correct result. Vertical film gate 

size is calculated by accounting image aspect ratio (vertical film size = horizontal film size 

/ aspect ratio).  

 

vii. Focal Length (mm) 

Specifies the equivalent focal length of the camera lens. This setting considers the 

system units configuration to produce the correct result. 

 

viii. Fov 

When enabled, sets the field of view directly without having to set up the film gate and 

focal length. 

 

ix. Zoom Factor 

Specifies a zoom factor. Values greater than 1.0 zoom into the image; values smaller 

than 1.0 zoom out. This is like a blow-up rendering of the image. For more information, 

see The Zoom Factor example below. 

x. Horizontal Shift 

Horizontally offsets the camera field of view as a fraction of the current view. For 

example, a value of 0.5 will offset the camera one-half of the current image width to the 

left.  

xi. vertical shift  

Vertically offsets the camera field of view as a fraction of the current view. For example, a 

value of 0.5 will offset the camera one-half of the current image height upwards.   
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F-Numberxii.

Determines the width of the camera aperture and, indirectly, exposure. If 

the Exposure option is checked, changing the f-number will affect the image brightness. 

For more information, see Exposure Control - f-number (s-top) example below. 

 

xiii. Target Distance 

Specifies the distance to the camera target for a targeted camera. 

 

 

 

Auto Guess Vert.xv.  

When enabled, preserves the vertical tilt when the camera is being animated. 

 

xvi. Specify Focus 

Specifies a focus distance different from the camera target distance. 

 

xvii. Focus Distance 

If specify focus is enabled, specifies the distance at which objects are in focus. 

 

xviii. Exposure 

When enabled, the f-number, shutter speed, and film speed (ISO) settings will affect 

the image brightness.  

 

xix. Vignetting 

When enabled, simulates the optical vignetting effect of real-world cameras. The strength 

of the vignetting effect can be specified, where 0.0 is no vignetting and 1.0 is normal 

vignetting.For more information, seeVignetting example below. 

 

White Balancexx.

Allows additional modification of the image output. Objects in the scene that have the 

specified color will appear white in the image. Note that only the color hue is taken into 

consideration; the brightness of the color is ignored. There are several presets that can 

be used, most notably the Daylight preset for exterior scenes. For more 

information,seeWhite Balance examplebelow. 

 

horizontal tilt buttons to achieve the 2-point peSSPective.

similar to applying a camera correction modifier. Use the Guess vertical tilt and Guess 
is

Allows the simulation of tilt  lenses for 2-point peSSPective. Changing these parameters  

xiv.  Vertical Tilt and Horizontal Tilt
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xxi. Shutter Speed (s^-1) 

Specifies the shutter speed, in inverse seconds, for the still photographic camera. For 

example, shutter speed of 1/30 s corresponds to a value of 30 for this parameter. For 

more information, see Exposure Control - Shutter Speed example below. 

 

xxii. Shutter Angle (deg) 

Specifies the shutter angle (in degrees) for the cinematic camera. 

 

xxiii. Shutter Offset (deg) 

Specifies the shutter offset (in degrees) for the cinematic camera. 

 

xxiv. Latency (s) 

Specifies the CCD matrix latency, in seconds, for the video camera. 

xxv. Film Speed (ISO) 

Determines the film power (i.e. sensitivity). Smaller values make the image darker, while 

larger values make it brighter. For more information, see Exposure Control: Film Speed 

(ISO) example below. 

 
 

Different camera Property4.2.1.3.

This parameter determines the zooming (In and Out) of the final image. It doesn't move 

the camera forward nor backwards. 

Exposure is on, f-number is 8.0, shutter speed is 60.0, film speed (ISO) 

is 200.0, vignetting is on, white balance is white. 

 

TVET SSP does not secure copyright of these pictures
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zoom factor = 1.0 

 
zoom factor = 2.0 

 

· Example: Exposure Control – f-number (f-stop) 

Note: All the images from the following examples are rendered using the V-Ray Sun and 

V-Ray Sky set with their default parameters. 

The f-number parameter controls the aperture size of the virtual camera. Lowering the f-

number value increases the aperture size and so makes the image brighter since more 

light enters the camera. In reverse, increasing the f-number makes the image darker, as 

the aperture is closed. This parameter also determines the amount of the Depth of Field 

(DOF) effect. 

Exposure is on, shutter speed is 60.0, film speed (ISO) is 200, Vignetting is on, white 

balance is white. 

| 168

TVET SSP does not secure copyright of these pictures



Teaching and Learning Guide: Information Technology (CAD) 3D Studio MAX 

 

 

Module -6 (LU-4): Develop 3D Models using 3D Studio Max 

 
  

 
f-number = 8.0 

 
f-number = 6.0 

 
f-number = 4.0 
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· 

 
Vertical tilt = Guess (2 point) 

 
Vertical tilt = -0.5 

 
vertical tilt = 0.5 

automatically, use the Guess vert tilt button.

done 
Using  this  parameter,  you  can  achieve  2-point  peSSPective.  To  have  that  

Vertical Tilt (Camera Correction)
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· Exposure, Field of View and Focus Distance 

The focus distance of the physical camera (as specified by either the camera target 

distance or the focus distance parameter) affects the exposure of the image and the 

field of view for the camera, especially if the focus distance is close to the camera. This is 

an effect than can be observed with real-world cameras as demonstrated in the images 

below. 

The setup is a white board with a small black rectangle and a camera in front of it. Notice 

how changing the focus distance produces images with different brightness even though 

the illumination and all other camera parameters are the same in both cases. Also notice 

the change in the field of view. 

 

The camera is focused on the white board;  

the grey color is approximately RGB 104, 104, 104. 

 

The camera is focused at infinity; 

the grey color is approximately RGB 135, 135, 135. 
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Side view of the camera focused on the white board. 

 
Side view of the camera focused at infinity. 

 

· Vignetting 

This parameter control the optical vignetting effect of real-world cameras. 

 
vignetting is 0.0 (vignetting is disabled) 
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vignetting is 1.0 

· White Balance 

Using the white balance color allows additional modification of the image output. Objects 

in the scene that have the specified color will appear white in the image. E.g. for daylight 

scenes this should be peach color to compensate for the color of the sun light etc. 

Exposure is on, f-number is 8.0, shutter speed is 200.0, film speed (ISO) is 200.0, and 

vignetting is off. 

 

 
white balance is white (255, 255, 255) 

| 173

TVET SSP does not secure copyright of these pictures



Teaching and Learning Guide: Information Technology (CAD) 3D Studio MAX 

 

 

Module -6 (LU-4): Develop 3D Models using 3D Studio Max 

 

 
white balance is blueish (196, 226, 255) 

 

 
white balance is peach (255, 214, 191) 

· Exposure Control  

i. Shutter Speed 

ii. Film Speed (ISO) 

 

Shutter Speedi.

The shutter speed parameter determines the exposure time for the virtual camera. The 

longer this time is (small shutter speed value), the brighter the image would be. In 

reverse - if the exposure time is shorter (high shutter speed value), the image would get 

darker. This parameter also affects the motion blur effect, see the Motion Blur Example. 

Exposure is on, f-number is 8.0, film speed (ISO) is 200, vignetting is on, and white 

balance is white. 
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shutter speed is 60.0 

 
shutter speed is 30.0 

 
Film Speed (ISO)ii.

The film speed (ISO) parameter determines the sensitivity of the film and consequently 

the brightness of the image. If the ISO value is high (film is more sensitive to the light), 

the image is brighter. Lower ISO values mean that the film is less sensitive and produces 

a darker image. 

Exposure is on, speedshutter is 60.0, f-number is 8.0, vignetting is on, and white 

balance is white. 
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film speed (ISO) is 400 

 
film speed (ISO) is 800 
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· Bokeh Effects 

 

These parameters control the bokeh effects when depth-of-field is enabled. 

i. Blades 

Defines the shape of the camera aperture. When disabled, a perfectly circular aperture is 

simulated. When enabled, a polygonal aperture is simulated, with the specified number of 

blades. 

 

ii. Rotation (deg) 

Defines the rotation of the blades in degrees. 

 

iii. Center Bias 

Defines a bias shape for the bokeh effects. Positive values make the outer edge of the 

bokeh effects brighter; negative values make the center of the effect brighter. 

 

iv. Anisotropy 

Allows stretching of the bokeh effect horizontally or vertically to simulate anamorphic 

lenses. 

 

v. Optical Vignetting  

Controls the strength of the optical vignetting, also known as and cat's eye vignetting. 

This effect is due to the fact that the shape of the bokeh highlights resembles the shape 

of the aperture. As the distance to the optical axis increases, the bokeh highlights are 

progressively narrowed and begin to resemble the shape of a cat's eye. The larger the 

distance from the image center, the narrower the cat's eye becomes. Optical vignetting 

tends to be stronger in wide angle lenses and large aperture lenses, but the effect can be 

noticed with most photographic lenses. 

Optical vignetting is currently very slow to calculate; it may introduce noise in the image 

that is difficult to clean. 
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Bitmap Aperturevi.  

Enables the use of an image (specified in the field below) to control the aperture shape 

as well as any dirt or scratches that may affect the bokeh. White signifies transparent 

areas and black signifies opaque areas. 

 

Affect Exposurevii.

 When enabled, the bokeh effects will affect the overall exposure of the image. 

 

viii. Bitmap Resolution 

Specifies the resolution at which the texture will be sampled when calculating the bokeh 

effects. 

 

Sampling Parametersix.

 

These parameters control the sampling for the virtual camera. 

x. Depth-of-Field

Enables depth of field sampling. For more information, see the Depth of Field example 

below. 

xi. Motion Blur 

Enables motion blur sampling.  

 
  depth-of-field is off 
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 depth-of-field is on, focus distance is 327cm 

 
  depth-of-field is on, focus distance is 1154cm 

 
motion blur is off 
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motion blur is on, f-number is 16.0, shutter speed is 30.0 

 
motion blur is on, f-number is 8.0, shutter speed is 125.0 

 
 

· Distortion Parameters 

 

The options in this roll-out control the lens distortion of the camera. 
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i. Distortion Type

Specifies how the distortion is determined. 

a) Quadratic: 

The default distortion type. It uses a simplified formula that is easier to calculate than 

the Cubic method.  

b) Cubic 

Used in some camera tracking programs like Synth Eyes, Boujou, etc. If you plan on 

using one of these programs, this distortion type should be used.  

c) Lens file 

Uses a lens file generated with the V-Ray Lens Analysis tool and specified in 

the Lens file field.  

d) Texture 

Uses a texture file generated in a third-party application (i.e. Nuke) and specified in 

the distortion map field. 

 

Distortion Amountii.   

Specifies the distortion coefficient for the camera lens when the Distortion type is set to 

either Quadratic or Cubic. A value of 0.0 means no distortion; positive values produce 

"barrel" distortion, while negative values produce "pillow" distortion.  

 
distortion is 1.0, distortion type is Quadratic 
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distortion is -1.0, distortion type is Quadratic 

 
distortion is 1.0, distortion type is Cubic 

 
distortion is -1.0, distortion type is Cubic 
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· Miscellaneous Parameters 

These parameters control various additional aspects of the camera. 

 

i. Horizon Line 

When enabled, displays the camera horizon line in the viewport. 

ii. Clipping: 

When enabled, turns on the camera clipping. 

iii. Near/Far Clipping Plane 

Specifies the near/far clipping range when clipping is enabled. 

iv. Near/Far Environment Range 

Specifies the near/far environment range (used by some atmospheric effects in 3ds Max). 

v. Show Cone 

Controls whether and when to show a preview of the camera field of view and focus 

plane. 

vi. Selected:  

Only shows the preview when the camera is selected.  

vii. Always 

Constantly enables the preview. 

viii. Never 

Constantly disables the preview. 

· V-Ray Physical Camera in 3D Max  

Please note than in 3D Max the V-Ray Physical Camera is not directly accessible through 

the menu. Instead the new 3D Max Physical camera type can be used: 
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The 3D Max Physical camera matches the V-Ray Physical Camera functionality. When 

you create a Physical camera, a new Exposure Control will be created automatically. You 

can use it to control the exposure of the rendered image. 
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Alternatively, you create a V-Ray Physical Camera by running the following command in 

the Max Script Listener: 

 

· Physical Camera Properties 

 
i. The Camera correction modifier will not work with the V-Ray Physical Camera. Instead, 

use the vertical tilt parameter of the camera for the same purpose. 

ii. There are three types of FoV (field of view): horizontal, vertical, and diagonal. Horizontal 

FoV depends on the film gate size, focal length, focus distance, and zoom factor. In 

addition to those four parameters, the vertical and diagonal FoV depend on the image 

aspect ratio. The V-Ray Physical Camera always uses horizontal FoV. 

iii. The DOF settings in the Render Scene dialogue have no effect when the V-Ray Physical 

Camera is used. Instead, you must use the DOF settings of the camera itself. 

iv. Some motion blur settings (Duration, etc.) have no effect on the V-Ray Physical Camera. 

Instead, motion blur is controlled by the camera itself (through the Shutter speed, etc. 

parameters). See also the Motion blur render parameters. 

v. When auto guess vert enabled, preserves the vertical tilt when the camera is being 

animated. 

 

4.2.1.4. How to adjust camera in a scene 

There are two types of camera view are mostly use in 3d max  

 

i. Man, Eye View 

ii. Bird Eye View 

 

i. How to adjust camera in Man Eye View  

a) open 3d max software. 

b) Add a scene in 3d max for camera. 
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ii. Select camera from create option  

 

iii. Set top view for adjust camera 
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iv. Select Camera 

v. Select move tool or press “W” 

vi. Move Camera to 5ft 6inch height.  

Note: in the prosses of man eye view we adjust the height  5'-6" to 6'. 

 

· How to adjust camera in Bird Eye View  

i. open 3d max software  

ii. Add a scene in 3d max for camera 
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iii. Select camera from create option  

 

iv. Set top view for adjust camera 

 

v. Set camera Bird eye view 

vi. show in fallowing step 

Note: in the prosses of Bird eye view we adjust the height  20' to 60' 
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4.3. Add Light for illumination to get requisite scene of 3D model 

 

For elevate your model, and create an experience the viewer will never forget. Lighting is crucial to creating 

not only realistic scenes, but also to leaving a lasting impression and conveying a certain feeling. All lights 

are not equal, and it is not surprising that many users are in the dark about which light best suits their 

needs. This will provide an overview of the lighting options available via the Enscape Objects window in 

SketchUp: spot light, sphere light, rectangular light, disk light and linear light. 

 

 

4.3.1. Add light to illumination the model  

It is a guide to adding lights to SketchUp Models, for renderings to be created with Render Plus 

Software, Inc. In this part, add lights to this SketchUp model. Select light fixtures from the Render 

Ready Components dialog and add them to the model. Create a new fixture by adding a bulb 

(lamp) to components already in place in the model to illuminate it. 

 

 

4.3.1.1. Working with Lights  

The procedures in this topic apply to both standard and photometric lights.  

 

· To create a light: 

i. On the Create panel, click (Lights).  

ii. Choose Photometric or Standard from the drop-down list. (Photometric is the default.)  

iii. On the Object Type rollout, click the type of light you want to create.  

iv. Click a viewport to create the light. This step varies slightly depending on the type of light. 

For example, if the light has a target, you drag and click to set the target’s location.  

Light objects replace the default lighting. As soon as you create a light, the default 

lighting is turned off. If you delete all lights in the scene, the default lighting is restored.  

v. Set the creation parameters. Like all objects, lights have a name, a color, and a General 

Parameters rollout.  

 

· To create shadows, do one of the following: 

i. In the General Parameters rollout, make sure on is checked in the Shadows group. 

Adjust shadow parameters in the Shadow Parameters rollout and the additional (Shadow 

Map, Advanced Ray-traced, Area Shadows, or Ray Traced Shadows) shadow rollouts.  

ii. Right-click the light and turn on Cast Shadows in the Tools 1 (upper-left) quadrant of the 

quad menu.  

a) Turning on Cast Shadows also turns on the on toggle in the Shadows group of the 

General Parameters rollout, and vice versa.  

b) Shadows are visible only when rendered, either in a full rendering, in a viewport, or 

with Active Shade.  
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Tip: To turn shadows on or off for multiple lights, select the lights and then use the Light 

Lister.  

c) You can set an object to not cast or not receive shadows. By default, objects do both. 

See Object Properties.  

 

· To control the display of light objects: 

On the Display panel, on the Hide by Category rollout, turn on Lights.  

All light objects in the scene disappear, but the lighting itself is unchanged.  

Light objects can cast light whether or not their display is turned off. The Zoom Extents 

commands are affected by whether light icons are displayed or not. When lights are 

displayed, Zoom Extents and Zoom Extents All includes the lights in the zoom.  

Tip: To control whether a light casts light in the scene, you can use it on toggle, or you 

can toggle its Render able property on the light's Object Properties dialog.  

 

· To change a light's parameters: 

i. Select the light.   

Tip: Lights can be hard to select by clicking. You can use the keyboard shortcut H to 

select the light by name.  

ii. Open the  Modify panel.  

iii. Change the light's parameters in the General Parameters rollout and other rollouts 

available for that light.  

· To position a light so it highlights a face: 

i. Make sure the viewport you plan to render is active, and that the object you want to 

highlight is visible in it.  

The result of Place Highlight depends on what is visible in the viewport.  

ii. Select a light object.  

iii. On the main toolbar, choose (Place Highlight) from the Align flyout.  

You can also choose Tools menu Place Highlight.  

iv. Drag over the object to place the highlight.  

When you place an omni light, free direct light, or a photometric Free Light, 3ds Max 

displays a face normal for the face the mouse indicates.  

When you place a target direct light or photometric Target Light, 3ds Max displays the 

light’s target and the base of its cone.  
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v. Release the mouse when the normal or target display indicates the face you want to 

highlight.  

The light now has a new position and orientation. You can see the highlight illumination in 

shaded viewports that show the face you chose, and when you render those views.  

Place Highlight works with any kind of selected object. You can also use Place Highlight 

with a selection set of multiple objects. All objects maintain their initial distance from the 

face.  

Note: For materials, highlight rendering depends on the material's specular properties 

and the type of rendering you use.  

When there are no lights in a scene, the scene is shaded or rendered with default 

lighting. You add lights to give the scene a more realistic appearance. Lighting enhances 

the clarity and three-dimensionality of a scene. In addition to general lighting effects, 

lights can be used to project images.  

Light objects replace the default lighting. As soon as you create a light, the default 

lighting is turned off. If you delete all the lights in the scene, default lighting is turned back 

on. The default lighting consists of two invisible lights: one is above and to the left of the 

scene, and the other is below and to the right.  

Tip: One way to begin your work on lighting a scene is to convert the default lighting into 

light objects by using the command Add Default Lights to Scene.  

Note: A scene's lighting is also affected by the Ambient Light setting on the Environment 

and Effects dialog Environment panel.  

 

4.3.1.2. Types of Lights 

3ds Max provides two types of lights: photometric and standard. All types are displayed in 

viewports as light objects. They share many of the same parameters, including shadow 

generators.  

i. Photometric Light 

ii. Standard Light 

iii. Area Light 

iv. V-Ray Light 

· Photometric Lights 

Photometric lights use photometric (light energy) values that enable you to more 

accurately define lights as they would be in the real world. You can set their distribution, 

intensity, color temperature, and other characteristics of real-world lights. You can also 

import specific photometric files available from lighting manufacturers to design lighting 

based on commercially available lights.  

Tip: For the most physically accurate, photorealistic lighting, use Photometric lights and 

the mental ray renderer. When you render with mental ray, use Final Gather and the 

mental ray Photographic exposure control. With this setup, you also can do lighting 

analysis of your model.  

· Standard Lights 

Standard lights are computer-based objects that simulate lights such as household or 

office lamps, the light instruments used in stage and film work, and the sun itself. 
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Different kinds of light objects cast light in different ways, simulating different kinds of light 

sources. Unlike photometric lights, Standard lights do not have physically-based intensity 

values.  

 
A nighttime scene that uses standard lights for atmosphere rather than realism 

 

i. You can animate not only the location of a light, but also its color, intensity and some 

other creation parameters.  

ii. You can use the Place Highlight command to change a light's position.  

iii. A Light viewport can be a useful way to adjust lights other than omni lights.  

iv. To simulate sunlight, use a daylight or sunlight system, which allows you to set the date, 

time, and geographic location of your model. The daylight system is photometric, while 

the sunlight system uses a standard directional light.  

Note: The standard Skylight light is distinct from the photometric daylight lights. The 

Skylight light is for use with light tracing.  

· Area Lights | V-Ray Light - V-Ray 3.6 for 3ds Max - Chaos Group Help  

The V-Ray Light is a V-Ray specific light source object that can be used to create 

physically accurate area lights of different shapes. Shapes are selected through options 

when creating the light via 3ds Max's Create panel (or Create menu), or, after the light is 

created, through the 3ds Max Modify panel. 

A V-Ray Light can be set to any one of the following types: 

i. Plane light: A flat rectangular light. 

ii. Disc light: A flat circular light. 

iii. Sphere light: A spherical light. 

iv. Mesh light: A mesh object converted to a light source. 



Teaching and Learning Guide: Information Technology (CAD) 3D Studio MAX 

 

| 193 

Module -6 (LU-4): Develop 3D Models using 3D Studio Max 

 
  

v. Dome light: A spherical or hemispherical light that shines inward from outside the scene 

extents. 

Note: The light type is set or changed with the Type parameter in the V-Ray 

Light General rollout. 

 

· V-Ray Light Types 

UI Paths 

Create menu > Lights > V-Ray > V-Ray Plane/Sphere Light > 

Click and drag in a viewport 

 

i. Plane Light 

A Plane light is a rectangular light source. This type of light is suitable for representing 

some recessed ceiling lighting, accent lamps, and other area-dependent light sources. Its 

light cone can be adjusted with the Directional parameter in the Rectangle/disc rollout.  
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Parameters of Plane Light 

 
Plane lights wireframe 
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Rendering with Plane lights only (with slight Bloom Effect) 

ii. Disc Light 

A Disc light is a circular light source with functionality similar to that of a rectangular-

shaped Plane light. Its light cone can be adjusted with the Directional parameter in the 

Rectangle/disc rollout. 

 
Parameter of Disk Light 
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Disc lights in viewport 

 
Rendering with Disc lights only (with slight Bloom Effect) 

iii. Dome Light

A Dome light shines light evenly inward from an area shaped as a spherical or half-

spherical dome that surrounds the entire scene. A dome light is commonly used with a 

high-dynamic range texture to shine light of various colors into the scene (image-based 

lighting).  
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Dome light in viewport 

 
Rendering with just a Dome light 

iv. Sphere Light 

A Sphere light is an area light whose surface area is shaped as a spherical surface that 

shines in all directions.  
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 Perimeters of Sphere Light 

 

 
Sphere lights represent light bulbs in hanging fixture 
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Rendering with Sphere lights only (with slight Bloom Effect) 

 

v. Mesh Light 

A Mesh light creates a light source from an object's surface area. It is useful for 

representing odd-shaped light sources such as string lights or lanterns.  

 
Mesh light wireframe 
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Rendering with lighting from Mesh light only 

 
 

· Lights - V-Ray for 3D Max  

V-Ray lights are designed specifically to work with V-Ray and optimize its features. V-

Ray also provides shadow options for standard 3ds Max lights, and utilities to assist in 

the lighting process. 

While you can use 3ds Max standard lights with V-Ray, V-Ray includes a set of lights 

designed specifically for rendering with the V-Ray engine. 

V-Ray also provides two shadow options for standard 3ds Max lights: Ray Traced 

shadows and Shadow Map shadows. These shadow types work similarly to their 

standard 3ds Max counterparts but are optimized to work with V-Ray. 

The V-Ray Light Meter utility helps evaluate the lighting in a scene so adjustments can be 

made to improve lighting. 
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As with standard 3ds Max lights, you can create these lights using the Lights tab on the 

Command Panel: 

i. Area lights shine from a light source contained within a specified area or boundary. There 

are several types of Area lights. 

ii. A Sun light simulates the sun, creating a single bright light for daytime exterior and 

interior scenes. 

iii. Photometric lights use IES files to determine the shape of the light cone and light falloff. 

iv. Ambient light is the kind of flat, evenly-distributed light seen at dusk and dawn in real life. 

Depending on the scene and the effect you are trying to create with light, you might elect 

to use only one type of light, or any combination of lights. 

 

4.3.1.3. Light Icons at a Glance 

 
i. Area light (default Plane light) 

ii. Sun light 

iii. Photometric light 

iv. Ambient light 

 

· Area Lights 

Area lights are useful for simulating man-made light sources in an interior environment, 

such as lamps. An Area light can have any one of many different shapes: plane, disc, 

sphere, or the shape of a mesh object. A dome light, which creates light within a dome 

shape to create a traditional global illumination setup, is also considered an Area light.  

 

· Sun Light 

A Sun light is a spherical light source placed at a specific location which simulates the 

sun in the sky. A Sun light has some unique qualities:  

i. Sun light rays that strike the scene objects are treated as parallel to one another 

regardless of how far the Sun object is placed from the scene objects, producing the 

parallel shadows that our own sun creates. 

ii. A Sun light is designed to be used with global illumination; when the light bounces around 

the scene, the resulting rendering looks very much like sunlight in real life. 

iii. A Sun light can work in conjunction with a Sky environment background to provide 

realistic lighting and coloring for the scene when used with GI. Often, Sun/Sky is the only 

lighting setup needed in the scene to produce a photo-real rendering. 

iv. The Sun/Sky combination is suitable for an exterior scene, or for an interior scene with 

windows or other openings for the sunlight to come through. 

· Photometric Lights 

 
Photometric lights are designed to simulate light sources exactly as they behave in real 

life by loading and using an IES (Illumination Engineering Society) file with details about 
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the light's behavior, such as how the light passes through lenses and its intensity and 

falloff.  

i. Ambient Light 

Ambient light permeates a scene and illuminates from all angles equally without providing 

contrast. 

ii. Shadows  

V-Ray also provides shadow types that work with standard 3ds Max lights. These 

shadow types take into account V-Ray-specific features such as V-Ray Proxies, 

Displacement, and Fur.  

iii. Utilities  

The Light Meter helper shows how a scene is illuminated, which can aid in 

troubleshooting or in adjusting lights.  

 

4.3.1.4. Parameters - General Rollout 

 
i. On: Turns the V-Ray Light on and off. 

ii. Type: Specifies the shape and function of the light: 

iii. Plane: The V-Ray Light takes the shape of a planar rectangle.   

iv. Sphere: The V-Ray Light has the shape of a sphere. 

v. Dome: The V-Ray Light emanates from a spherical or hemispherical dome around the 

scene extents. See the Dome Light page.  

vi. Mesh: Allows the usage of any mesh object as the shape of the light.  

vii. Disc: The V-Ray Light takes the shape of a planar disc.  

viii. Targeted: When enabled, a separate target object is attached to the light source. This 

target object can be moved separately from the light source, making it easier to point the 

light within the scene. The value specifies the distance from the light source to the target. 

While any type of V-Ray Light can have a target, the target is truly useful only 

with Plane and Disc lights. This option can be changed only on the Modify panel. 

ix. Half-length: The half-length of a Plane light source, measured in scene units. 

x. Half-width: The half-width of the Plane light source, measured in scene units. 

xi. Radius: The radius of the Sphere or Disc light source, measured in scene units. 

xii. Units: Specifies the light units. Using correct units is essential when you work with 

the Physical Camera | V-Ray Physical Camera. The light will automatically take the 

scene's unit scale into consideration to produce the correct result for the scale you are 

working with. 

xiii. Default (image): The color and multiplier directly determine the visible color of the light 

without any conversion. The light surface will appear with the given color in the final 

image when seen directly by the camera (assuming there is no color mapping involved). 
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xiv. Luminous power (lm): Total emitted visible light power measured in lumens. When this 

setting is used, the intensity of the light does not depend on its size. A typical 100W 

incandescent light bulb emits about 1500 lms of light. 

xv. Luminance (lm/m²/sr): Visible light surface power measured in lumens per square meter 

per steradian. When this setting is used, the intensity of the light depends on its size.  

xvi. Radiant power (W): Total emitted visible light power measured in watts. When using this 

setting, the intensity of the light does not depend on its size. Keep in mind that this is not 

the same as the electric power consumed by a light bulb for example. A typical 100W 

light bulb only emits between 2 and 3 watts as visible light.  

xvii. Radiance (W/m²/sr): Visible light surface power measured in watts per square meter per 

steradian. When this setting is used, the intensity of the light depends on its size. 

xviii. Multiplier: Multiplier for the light color, and also the light intensity for some Units settings. 

xix. Mode: Specifies the mode in which the color of the light will be determined: 

xx. Color: When this option is selected, the Color swatch specifies the color of the light rays 

and of the light source itself when visible in renderings. For Units settings other 

than Default (image), this color is normalized so that only the color hue is used.  

xxi. Temperature: When this option is selected, the color of both light rays and the light 

source itself is specified by the Temperature value expressed in Kelvin. 

xxii. Texture: Enables the use of a texture for the light surface when a Plane or Disc light 

type is used. The button under this option selects the map to use. The texture intensity is 

also affected by the Multiplier value. 

xxiii. Res: Specifies the resolution at which the texture is resampled for importance sampling. 

 

4.3.1.5. How to adjust sun light View  

i. open 3d max software  

ii. Add 3d file for lighting  

iii. Show in fallowing  
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iv. 

 

 

4.3.2. Apply different rendering techniques 

There are 3 techniques for applying rendering  

i. V-Ray 
ii. Corona 
iii. scanline 
 

4.3.2.1. V-Ray  

· Overview 

The 3ds Max Render Setup window hosts many V-Ray settings for both V-Ray and V-

Ray GPU. Choosing the V-Ray GPU engine changes the available settings. For more 

information about the V-Ray GPU render settings, follow the link. 

This section provides information on render setup with the V-Ray engine. 

The Common tab contains no custom or unique V-Ray settings. For more details on the 

parameters found under this tab, please refer to the 3ds Max help documentation. 

Go to peSSPective view to insert sun
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· Selecting the V-Ray Renderer 

In order to use V-Ray, you must first select one of its renderers as your current renderer. 

i. Open the Render Setup window. See below where can you find the Render Setup 

window.  

ii. At the top of the Render Setup window, choose Production Rendering Mode as 

the Target. 

iii. For Renderer, choose V-Ray. 

Note: Older scenes saved with Active Shade mode can still be opened in V-Ray Next in 

order to convert them to Production Rendering Mode. 

 

· UI Paths 

 
iv. Main Toolbar > Render Setup button 

v. Rendering menu > Render Setup... 

vi. V-Ray Toolbar > V-Ray Render Settings button 

 

vii. Render Setup window > Renderer > V-Ray 
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· Render Settings Tabs  

V-Ray parameters are under several tabs in the Render Setup window. Additionally, each 

tab is divided into several rollouts. 

i. V-Ray tab - Selection of the image sampler type for antialiasing and image filtering, 

customizable settings for cameras and environment, VFB settings. 

ii. GI tab - Selection and settings for primary and secondary GI engines, GI caustics. 

iii. Settings tab - Global settings including displacement and texture settings. 

iv. Render Elements tab - Creation and control of render elements for beauty pass 

compositing and post-production. 

In V-Ray, the two tools that most greatly impact the balance of render quality vs. speed 

are the image sampler (under the V-Ray tab) and GI engine(s) (under the GI tab). 

Learning the basics of how these two features work will greatly enhance your ability to 

adjust settings in V-Ray and maximize image quality while keeping render times to a 

minimum. See the linked pages for explanations on how these features work. 

The Render Setup dialog has multiple panels. The number and name of the panels can 

change, depending on the active renderer. These panels are always present:  

a) Common panel  

Contains the general controls for rendering, such as whether to render a still image or 

an animation, setting the resolution of rendered output, and so on.  

b) Renderer panel 

Contains the main controls for the active renderer.  

Tip: Each renderer has different and unique capabilities. Based on these, you decide 

which renderer you want to use for each scene. It is a good idea to design materials with 

a particular renderer in mind.  

4.3.2.2. Corona Renderer technique 

i. On the slaves and master: Corona Renderer for 3ds Max - it is best to use the newest 

version available at https://corona-renderer.com/download/  
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ii. On the slaves and master: 3ds Max - any version supported by your current Corona 

Renderer version 

 
 

iii. On the slaves and master: Autodesk Backburner version matching your 3ds Max version 

- it is included in the 3ds Max installation package, or can be downloaded and installed 

separately. You need to have the exact version matching your 3ds Max version (for 

example Backburner 2019 if you are using 3ds Max 2019). 

 
 

iv. On the slaves: Corona DR Server - it is included in the Universal Installer, and by default 

it is installed into C:\Program Files\Corona\DR Server\DrServer.exe. 

 

 
 

Note: Autodesk Backburner is not directly used in Corona Distributed Rendering process 

but it is required for it to work correctly. 

Note: Starting with Corona V3, the DR server is installed in a separate subfolder of the 

main Corona install folder (in Corona versions prior to V3, the DR server was installed 

into the Corona root folder, C:\Program Files\Corona) 

Note: For Backburner installation/uninstallation troubleshooting, see: Distributed 

Rendering does not work - "Unknown error while loading application" 

· Further requirements: 

i. DrServer.exe must be running on all slaves 

ii. All slaves must be on the same LAN network and sub-network 

iii. Both 3dsmax.exe and DrServer.exe must be allowed to communicate (both incoming 

and outgoing connections) on these two ports: TCP 19667 and TCP 19668. Sometimes 

adjusting firewall settings may be necessary 

iv. Both the workstations and the render nodes taking part in the distributed rendering must 

have Corona Renderer licenses active. 
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v. 3ds Max does not have to be activated on the slaves. You may use the demo license, 

or even an expired demo license and that is absolutely fine with Autodesk licensing terms 

as 3ds Max will be used in command line mode only, without the user interface visible.  

· Crona Render Setup 

i. On all slaves: run the DrServer application 

 
 

ii. On the master PC: in 3ds Max, go to RenderSetup > System > Distributed Rendering, 

tick the "Enable" checkbox, and press "Search LAN" 
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iii. On the master PC: wait for the addresses or names of your slave PCs to appear on the 

list (or enter their network names or IPs manually via the "Add" button at the bottom) 

 
On the master PC: start rendering 
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iv. On all slaves: a new 3ds Max instance should appear after some time (minimized, so you 

won't be able to see its UI or the VFB), then it should start rendering your scene, and 

sending rendered data to the master PC based on "Synchronization interval" time 

specified in the DR rollout on the master. 

v. On master PC: you can see Distributed Rendering information in the DR tab of the 

Corona VFB 

 
 

Note: you can also check "Search LAN during render" option in the DR rollout on the 

master PC to make Corona search for any machines with the DrServer application 

running and automatically add them to the rendering even after it has already started. As 

a result, any machines where the DrServer application was launched at some point 

during rendering will join, and any machines where the rendering was interrupted due to 

an error or user intervention will be able to re-join the rendering again. 
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The rendering will stop after it reaches the given render limit, or after you stop it manually 

on the master computer. In case of render limits, each limit is considered based the 

master machine statistics, not for each of the slaves. For example, if you set the limit to 

10 minutes, the rendering will stop after 10 minutes pass on the master machine, not on 

the slaves. If you set it to 100 passes, it will stop after the total number of passes 

(reported on the master machine) will reach 100, regardless of how many passes each 

slave has rendered. If you use the noise limit, it will stop once the target noise level is 

reported on the master machine.  

 

· Distributed Rendering Troubleshooting 

For known solutions to problems with Distributed Rendering please refer to our  

Distributed Rendering Troubleshooting Section. 

Note: the error messaging system will catch the known issues, and will warn you about 

any detected problems. This is often helpful for troubleshooting.  
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· Common issues: 

First diagnostic step when experiencing DR issues is always disabling all installed 

antivirus / firewall software on both the master and render node machines. 

This does not mean that AV / firewall software should be always disabled when using 

DR. But it can verify if the issue is related to this software at all. If so, then further steps 

can be made to fix the issue. The usual solution is adding custom rules to Windows 

Firewall to allow DR.  

 

4.3.2.3. Scanline Technique  

Rendering creates a 2D image or animation based on your 3D scene. It shades the 

scene's geometry using the lighting you've set up, the materials you've applied, and 

environment settings such as background and atmosphere.  

The Render Setup dialog has multiple panels. The number and name of the panels can 

change, depending on the active renderer. These panels are always present:  

i. Common panel 

Contains the main controls for any renderer, such as whether to render a still image or an 

animation, setting the resolution of rendered output, and so on.  

ii. Renderer panel 

Contains the main controls for the current renderer.  

Additional panels can appear, depending on which renderer is active. Five renderers are 

provided with 3ds Max. Their controls are described in the section Renderers. Additional 

renderers might be available as third-party plug-in components.  

At the bottom of the Render Setup dialog are controls that, like those in the Common 

Parameters rollout, apply to all renderers.  

Note: Bitmap paging is always active and is managed automatically, enabling you to 

render scenes with large bitmaps, a large number of bitmaps, or very high-resolution 

images (for example, 5,000 x 5,000 pixels or more).  

· Standard and ActiveShade Renderers 

In 3ds Max, there are two different types of renderings. Production rendering is active by 

default, and is typically the one you use for finished renderings. This type of rendering 

can use any of the three aforementioned renderers. The second type of rendering is 

called ActiveShade. An ActiveShade rendering uses the default scanline renderer to 

create a preview rendering that can help you see the effects of changing lighting or 

materials; the rendering updates interactively as you change your scene. Rendering with 

ActiveShade is, in general, less precise than production rendering.  

Another advantage of production rendering is that you can use different renderers, such 

as the mental ray or VUE file renderer.  

To choose between production and ActiveShade rendering, use the radio buttons 

described in the Interface section, following. To change the renderer assigned to 

production rendering, use the Assign Renderer rollout.  
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· Procedures 

To render a still image: 

i. Activate the viewport to render.  

ii. Click (Render Setup).  

iii. The Render Setup dialog opens, with the Common panel active.  

iv. On the Common Parameters rollout, check the Time Output group to make sure the 

Single option is chosen.  

v. In the Output Size group, set other rendering parameters or use the defaults.  

vi. Click the Render button at the bottom of the dialog.  

vii. By default, rendered output appears in the Rendered Frame Window.  

 

· To render an animation: 

i. Activate the viewport to render.  

ii. Click (Render Setup).  

iii. The Render Setup dialog opens, with the Common panel active.  

iv. On the Common Parameters rollout, go to the Time Output group and choose a time 

range.  

v. In the Output Size group, set other rendering parameters or use the defaults.  

vi. In the Render Output group, click Files.  

vii. On the Render Output File dialog, specify a location, name, and a type for the animation 

file, and then click Save.  

Typically, a dialog appears that lets you configure options for the chosen file format. 

Change settings or accept the defaults, and then click OK to continue.  

viii. The Save File checkbox turns on.  

ix. Click the Render button at the bottom of the dialog.  

Note: If you set a time range and do not specify a file to save to, the animation is 

rendered only to the window. This can be a time-consuming mistake, so an alert warns 

you about it.  

Tip: Once you have rendered the animation this way, you can render it again without 

using the dialog by clicking (Render Production) or pressing F9.  
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· Interface 

 

i. Preset  

From this drop-down list you can choose a set of preset rendering parameters, or load or 

save rendering parameter settings. See Preset Rendering Options.  

ii. View  

Shows the viewport that renders when you click the Render button. To specify a different 

viewport to render, choose it from the list or activate it in the main user interface.  

The drop-down list contains all viewports available in all viewport layouts. Each viewport 

is listed with the layout name first, followed by a hyphen and then the viewport name. For 

example: Row 1, Row 2 - Front. For this reason, to identify viewports easily, give your 

layouts meaningful names, such as Closeups.  

Activating a different viewport in the main interface automatically updates this setting if 

Lock to Viewport (see following) is off.  

iii. Lock View  

When on, locks the view to the one shown in the Viewport list. This enables you to adjust 

the scene in other viewports (which become active as you use them), and then click 

Render to render the viewport you originally chose. When off, Render always renders the 

active viewport.  

iv. Render  

When ActiveShade is chosen, the name of this button changes to ActiveShade, and 

clicking it opens a floating ActiveShade window.  

If the scene you're rendering contains bitmaps that cannot be located, a Missing External 

Files dialog opens. This dialog lets you browse for the missing maps, or continue to 

render the scene without loading them.  

[Render button drop-down menu]  
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Click the down-arrow to display a drop-down menu that lets you choose various 

rendering options.  

 
 

· Production Render Mode 

(The default.) While active, clicking Render uses production mode.  

i. Iterative Render Mode 

While active, clicking Render uses iterative mode.  

ii. Active Shade Mode 

While active, clicking Render uses ActiveShade.  

iii. Submit to Network Rendering 

Submits the current scene to network rendering. When you choose this option, 3ds Max 

opens the Network Job Assignment dialog.  

This choice does not affect the state of the Render button itself, which you can still use to 

launch a Production, Iterative, or ActiveShade rendering.  

Changing the render mode on this menu changes the comparable setting on the Render 

flyout.  



Teaching and Learning Guide: Information Technology (CAD) 3D Studio MAX 

 

| 216 

Module -6 (LU-4): Develop 3D Models using 3D Studio Max 

 
  

 
 

Rendering Progress dialog 

 
When you click Render, a rendering progress dialog shows the parameters being used, 

and a progress bar. The rendering dialog has a Pause button to the left of the Cancel 

button. When you click Pause, the rendering pauses, and the button's label changes to 

Resume. Click Resume to continue with the rendering.  

Note: The mental ray renderer does not support the Pause button. You can cancel a 

mental ray rendering, but you can't pause it.  
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4.4. Assign camera to execute different view of 3D model. 

 
Using different camera views is therefore very necessary to learn especially when making 3d SketchUp 

model.  To get a better understanding of 3D cameras, imagine you are shooting a movie. You have to set 

up a scene that you want to shoot and you need a camera. To get the footage, you'll roam through the 

scene with your camera, shooting the objects in the scene from different angles and points of view. 

 

4.4.1. Create Camera 

Two methods of creating camera 

i. Create menu > Cameras > select camera 

 
 

ii. 

 

 
 

iii. After you have created a camera, you can change viewports to display the camera's point 

of view.  

Choose PeSSPective viewport > Views menu > Create Camera from View.
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iv. While a camera viewport is active, the navigation buttons change to camera navigation 

buttons. 

 

Note: While you use the navigation controls for a camera viewport, you can constrain 

Truck, Pan, and Orbit movement to be vertical or horizontal only with the “SHIFT” key. 

4.4.1.1. Choosing a Camera for Vertical Views 

If you need an animated camera to look vertically upward or downward, use a free 

camera. If you use a target camera you might run into a problem of unexpected 

movement.  

 
 

4.4.1.2. Camera Object Icons 

Camera objects are visible in viewports unless you choose not to display them. However, 

the geometry that appears in the viewport is only an icon meant to show you where the 

camera is located and how it is oriented. 

· Procedures 

To render a scene using a camera: 

i. Create the camera and aim it at the geometry you want to be the subject of your scene. 

To aim a target camera, drag the target in the direction you want the camera to look. To 

aim a free camera, rotate and move the camera icon. 

ii. With one camera selected, or if only one exists in the scene, set a Camera viewport for 

that camera by activating the viewport, then press C. If multiple cameras exist and none 

or more than one are selected, 3ds Max prompts you to choose which camera to use. You 

can also change to a Camera viewport by clicking or right-clicking the Point-Of-View. 

iii. Adjust the camera's position, rotation, and parameters using the Camera viewport’s 

navigation controls. Simply activate the viewport, then use the Truck, Orbit, and Dolly 

Camera buttons. Alternately you can select the camera components in another viewport 

and use the move or rotate icons. 

iv. Render the camera viewport. 
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· Different View of 3D Model 

i. view 01 

ii. Man Eye view 

iii. Camera height 5'6" 

 

iv. View 2 

v. Bird Eye view 

vi. Camera height 35' 

 

  



Teaching and Learning Guide: Information Technology (CAD) 3D Studio MAX 

 

| 220 

Module -6 (LU-4): Develop 3D Models using 3D Studio Max 

 
  

4.5. Render the 3D model according to required image size or resolution & 
orientation. 

 

Rendering or image synthesis is the automatic process of generating a photorealistic or non-

photorealistic image from a 2D or 3D model(or models in what collectively could be called a scene file) by 

means of computer programs. Also, the results of displaying such a model can be called a render. A 

scene file contains objects in a strictly defined language or data structure; it would contain geometry, 

viewpoint, texture, lighting, and shading information as a description of the virtual scene. The data 

contained in the scene file is then passed to a rendering program to be processed and output to a digital 

image or raster graphics image file. The term "rendering" may be by analogy with an "artist's rendering" of 

a scene. 

 

4.5.1. Render setup for rendering step by step 

i. open the dialog box for rendering 

 

 
 step-01 

ii. There are 5 steps in render setup 

a) common 

b) v-ray 

c) GI 

d) Setting 

e) Render Element 

 
 

a) Common  

Dialogue box open and select output size 
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b) V-Ray  
This is second window of render setup in this window. we will learn in this 
window about frame buffer, global switches, image sampler (Animalizing), 
adaptive image sampler, global DMC, environment, color mapping, camera. 

 

 
 

c) Frame Buffer 

frame buffer use for saving render image in drive:  

Ø use superset render channel  

Ø Give path to Save file in the drive 
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d) Global Switches 

Global switches use for control light, shadows, reflection, refraction, map etc. 

 

 
 
 

e) Image Sampler (Antialiasing) 
Image sampler use for select filter of render image. There are many types of filter 

in image sampler. 

 



Teaching and Learning Guide: Information Technology (CAD) 3D Studio MAX 

 

| 223 

Module -6 (LU-4): Develop 3D Models using 3D Studio Max 

 
  

 
 

f) Adaptive Image Sampler 

Adaptive image sampler uses for noise control 

Ø Min Subdivs should be 5 

Ø Max Subdivs should b 10 

Ø For best quality of render 
 
 

 
 

g) Global DMC 
Global DMC also use for quality control 

 
 

h) Environment  
Environment is use for create sky in render 
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i) Color Mapping 
Color mapping use control for darkness and brightness and also control Gemma 

 

 
 
 
 

j) Camera  
camera use for 360 renders 

 
 

k) GI 
Gi command have 4 window global illumination, irradiance map, light cache  

caustic 
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l) Global Illumination 
Global illumination is use for lighting effects 

 

` 
 

m) Irradiance Map  
irradiance map use for resolution of rendering like low, medium, high. 

 
 

n) Light Cache 
Light cache is also use to control quality of render and increas of timing of render  
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· To create a new scene using the File menu: 

Do one of the following: 

i. Select File menu  New. 

ii. Press Ctrl + N. 

From the submenu or dialog, select one of the listed options: 

a) New All 

Clears all of the current scene's contents (default). 

b) Keep Objects 

Keeps the objects in the scene, but removes animation keys and links between objects. 

Warning: Don't use this option if the scene contains linked or imported objects you wish 

to keep. 

c) Keep Objects and Hierarchy 

Keeps the objects and hierarchal links between them, but removes any animation keys. 

Note: If the current scene has any file links, 3ds Max performs a Bind operation on all 

linked files. 

d) New from Template 

Opens the Template Manager, where you can select from provided sample scenes or a 

template you created 

Note: If the current scene has any file links, 3ds Max performs a Bind operation on all 

linked files. 

e) New from Template 

Opens the Template Manager, where you can select from provided sample scenes or a 

template you created 
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4.5.2. 3D MAX and V-Ray Tutorial:  

Basic daylight interior visualization for beginners – Render like a photographer tonytextures.com  

 

This is Kanak and I want to explain you here exclusively on tonytextures.com how you can easily 

set up a daylight interior scenery in 3ds MAX by using V-Ray rendering engine with a bit of 

Photoshop correction of the RAW rendering afterwards. 

I would love to call my approach rendering through the eye of a photographer. I think this is the 

best way for you to learn how to render without knowing a thousand of parameter. I will go 

through following steps to explain my method: 

i. Modeling the scene 

ii. Creating the materials for the scene 

iii. Select your camera view 

iv. Set up the lighting day or night. Remember: Because of we are using the photographic 
way we do not need to change the lights default parameters a lot. Instead we can 
manage it with the camera. 

v. Choose the correct camera exposer. This is really important because with right exposer I 
mean right shutter speed, F-number and ISO (parameters that determine photos in real 
live) It is important to understand that a physical camera in V-Ray needs to be set up just 
like the real worlds DSLR cameras 

vi. The post production is the last step – but it is a really important one! Every photographer 
tries to get the most out of his photos in Photoshop, so do we. Therefore, I save my 
rendering in RAW format to have full control in Photoshop afterwards. 
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· Let´s get started: 

i. The room that we will work with  

I have created a standard 3d office room that should be used for this interior daylight 

rendering tutorial. I also put in some basic 3D furniture low polygonal models – nothing 

special. 

ii. 3D Models for V-Ray interior architectural scenery  

Because the light should fall through the window, I also imported very simple vertical 

blind as window curtain to create some nice effects with the daylight. 

iii. Vertical blinds for window  

The first step is to “Enable Gamma/LUT Correction”. You will find it via 

Customize>Preferences on the “Gamma” tab. 

iv. Gamma LUT Correction in 3DS MAX  

Basically, gamma is the relationship between the brightness of a pixel as it appears on 

the screen, and the numerical value of that pixel in the rendering. Because we want to to 

render a RAW image (physically correct) we deactivate with this step the increase of 

brightness which will normally automatically be created because the screen itself will 

reduce the brightness again. 

Background information for geeks: Almost every computer monitor has one thing in 

common. They all have an intensity to voltage response curve which is roughly a 2.5 

power function. Don’t be afraid, this just means that if you send your computer monitor a 

message that a certain pixel should have intensity equal to x, it will actually display a 

pixel which has intensity equal to x ^ 2.5 Because the range of voltages sent to the 

monitor is between 0 and 1, this means that the intensity value displayed will be less than 

what you wanted it to be, but we want the real values because we export the result as 

RAW and correct it in Photoshop afterwards. 

v. Room without furniture  

First, I create some V-Ray materials for the main elements. Open the material editor 

(shortcut M) and pick an unused material. For the dining table top I created an easy 

marble material, but you can use also another texture of your choice. 

a) Tile able marble texture image as “Diffuse Map” 

b) Change the color of the reflection to white 

c) Reflection Glossiness: 0.9 

d) Sub division: 25 

vi. Creating a marble V-Ray material  

For the chair I created two different V-Ray materials. One is a SS Steel metal material 

and the other one looks just like simple white plastic. See the settings I made in the 

screenshot: 

vii. SS Steel Material for chair  
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viii. White glossy plastic material for chair  

For the other table I also used a marble texture like for the other table as well: 

ix. Marble material table top  

Afterwards we create also a V-Ray material for the basin 

a) Choose a white for the diffuse color 

b) Choose a grey color for the reflection color 

c) Activate “Fresnel reflections” 

d) Refl. Glossiness value: 0.9 

x. Create 3ds MAX -Material for ceramic basin glossy look  

For the floor I use this high-resolution tile able strip parquet texture: 

xi. I use the texture also as diffuse map in 3ds MAX and add afterwards some glossiness 

and reflections: 

a) Set reflection color to light white 

b) Activate “Fresnel reflections” 

c) Refl. Glossiness value: 0.9 

d) Sub division: 10 

xii. Strip Parquet Wood Tile able Texture in 3ds MAX  

Next, we will create a V-Ray physical camera. To do so, select Create>Camera>V-Ray 

(from drop down menu) >physical camera. 

xiii. Setup V-ray physical camera  

Afterwards press “c” to activate your camera view. Then choose a nice camera position. 

xiv. Position your camera  

The light should be generated by a light emitting plane that we place in the window. To 

do so create a V-Ray plane light by selecting Create>Light>V-Ray>V-Ray Light. 

Afterwards modify the parameters like shown in the screenshot: 

xv. V-Ray Plane Light for Interior Architectural Scene  

It is important to activate “Cast Shadows” to ensure that shadows will be generated and 

also activate “Invisible” because the plane itself should not be visible in the final 

rendering. 

In addition, we need a V-Ray sun. To do so select Create>Light>V-Ray>V-Ray Sun and 

set the target inside of the window. When you are going to create a sun you need to 

confirm the upcoming dialogue („Would you like to automatically add a V-Ray Sky 

environment map”) to automatically add a V-Ray Sky environmental map. 

xvi. Setup V-Ray sun and sky  

xvii. Physical camera setup  
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For the camera setup I first changed the custom balance to white. If you want to make 

your image brighter then you have two possibilities (like you would have with your DSLR-

camera as well): 

a) You can lower the f-number 

b) You can change the shutter speed for the camera 

Let me explain the four most important parameters of a physical V-Ray Camera: 

Ø Shutter speed: Stutter speed can control the brightness of your scene.  A lower shutter 

speed lets more light reach the photo chip of a DSLR. More light = brighter image. Or the 

other way around a faster shutter speed give less light pass – the image becomes darker. 

In real life your image can have blur effects when the shutter speed is too long and your 

scenery is in motion. But in 3ds MAX it will not have a blur effect because nothing is 

moving. 

Ø F-Number: F-number is the parameter of your camera’s aperture. A lower f-number mean 

wider aperture and thus more light = brighter image. A higher f-number means a narrow 

aperture and thus less light = darker image. It is important that it affects the depth of field 

but in V-Ray if you are not using the depth of field effect then that also doesn’t matter. 

Ø ISO: ISO is the film speed. Higher ISO = bright image, lower ISO = dark image. In real life 

a higher ISO can cause a noisy image but not in a V-Ray physical camera. 

Ø White balance: It means to identify the right white color for camera. You can make it 

neutral in V-Ray 

So finally, you see that the physical V-Ray is even more powerful as a real world DSR 

camera and does not have some major disadvantages. 

After this short-detailed description, I change some parameters in the Render Setup to 

achieve a fast, but also realistic result. 

c) Common Settings àSet Output Size to “HDTV (video)” 

d) V-Ray Settings 

Ø Activate: Frame buffer/Enable built-in Frame Buffer 

Ø Activate: Global switches/Lights and Global switches/Shadows 

Ø Select: Image sampler (Antialiasing)/ Type: Adaptive DMC 

Ø Activate Image sampler (Antialiasing)/Antialiasing filter: on and select V-RayTriangleFilter 

Ø Select: Color mapping/Type: Exponential and make settings like shown in the screenshot 
blow 

e) Indirect Illumination 

Ø Activate V-Ray Indirect Illumination 

Ø Select Irradiance map as GI engine under Primary bounces 

Ø Select Light chache as GI engine under Secondary bounces 

Ø Set parameters at Detail enhancement 

Ø Set Subdiv to 1500 at Calculation parameters 

Ø Activate Store direct light at Calculation parameters 
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Ø Activate Pre-filter under Reconstruction parameters and also “Use light cache for glossy 
rays” with a Retrace threshold of 1.0 

f) Settings 

Ø Set Min samples to 15 

Ø Set noise threshold to 0.005 

Ø Set Dynamic memory limit to 7000 MB 

Ø And finally activate Low thread priority 

 

xviii. Render set up  

Now it is finally time to start rendering and get results. Here we go! 

xix. Raw out put  

This is my raw output – it’s a bit dark from my point of view but that’s okay. I’ll love to 

handle this at Photoshop. But of course, you can also make additional enhancements by 

changing the shutter speed and f-number at you V-Ray physical camera directly. 

Okay here we are in Photoshop. Go to Filter>Camera raw filter: 

xx. Import to photoshop and edit RAW rendering  

And just play around for your right exposer and with the color. It is self-explaining and you 

will get a feeling for the parameters just by testing these out by yourself. See my 

parameters I ended up with here: 

xxi. Parameters in Photoshop to edit RAW image  

So, this is basically it and I am pretty happy with the result: 

xxii. Final rendering of 3D interior architectural visualization with V-Ray  

I know there are quite a lot of settings to be made, but I would recommend you to set up 

your dummy scenery and use it for your future project as well. 
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Practice-1 

Apply the following effect to model (Previosly create in LU-2/prictice -1 

 

 
 

There are 3 passes of render procedure: 

 

1) procedure-01 
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2) Procedure -02 

 

 

3) Final render Day View 

 

man, eye view 
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Bird Eye View 
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Summary of Module 

 

This module is designed to provide a comprehensive 3D Max modeling and rendering solution to interior designer 

architects and engineering (electrical, mechanical, civil). Trainee will cover the interface and proper workflow for 

setting up 3Ds max project with cameras lighting and rendering. He can handle more complex scenarios and 

techniques which are found in 3Ds max. 

Trainee will learn to demonstrate 3D Max interface and use different types of tool bar like Quick Access tool bar, 

main tool bar, ribbon tool Bar etc. Also explain that how to merge and import the link file DWG, FBX and RVT into 

3D max. 

Trainee will learn how the following application by applying different modifier for modification and also explain the 

modifier stack control. Import the 2D DWG Drawing t into 3D max studio and working with it also explain in this 

units.  

He will learn about how to apply textures and materials to a model in 3Ds max in a simple and easy way, how to 

make them in Blender, a free, open-source 3D modeling program. He will also learn about edit materials and texture. 

The Material Editor provides functions to create and edit materials and maps to get realistic outcome. 

Render is the most impotent subject, trainee will be able to install different Plug-ins like v-ray, scanline, corona how 

to adjust camera and light. 
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Question and Answers: 

 
Demonstrate the 3D Max.FAQ -1

One of the most important aspect of using 3dsAnswer:  Max is its versatility. Many program functions    are 

available from multiple interface elements.  

 

Explain the Quick Access tool bar.FAQ -2

The Quick Access toolbar provides some of thAnswer: e most commonly used file-management commands, 

as well as new, open Save, Undo/Redo and import 

 

Define the Command Panel.FAQ -3

The command panel comprises six user-interfaAnswer: ce panels that give you access to most of the 

modelling features of 3ds Max 

 

Write Down the Option of Camera View Port CoFAQ -4 ntrol.  

The View port control is used for camera settiAnswer: ng like Dolly camera, Roll Camera and Truck Camera 

etc. 

 

FAQ -5

Answer:

 

What is the port view?FAQ -6

Viewport Layouts gives you a special tab barAnswer:  for switching quickly among any number of different 

viewport layouts. 

 

What are short keys of Move, Rotate, Scale objFAQ -7 ect, Window selection and Select and Link.  

Move: WAnswer:

Rotate: E 

Scale: R 

 

Explain the Utilities Panel.FAQ -8

By default, the command panel appears at theAnswer:  right of the 3ds Max window. You can "dock" it along 

other edges of 3ds Max window or make it a floating panel.  

 

Write Down the note on Transforms and its optFAQ -9 ion. 

Answer: A transform is an adjustment of an object’s position, orientation, or scale, relative to the 3D world 

(or world space) in which you’re working. 

 

Explain the Scene Explorer.FAQ -10

Scene Explorer provides a modeless dialog for vAnswer: iewing, sorting, filtering, and selecting objects 

in 3ds Max. 

 

Write down the function of modify?FAQ-11

The function of modify is to change the sizAnswer: e of model. 

 

How to apply polygon with Edit Mash ExplainFAQ-12 step by step? 

Answer: 

i. Select box (object) and click on the modify tool  

light viewports all have specialized controls.

and 
The  navigation  controls  depend  on  the  active  viewport.  PeSSPective,  orthographic,  camera,  
Explain the viewport Navigation Control.
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ii. Set parameters according length, width, height  

iii. Set segments of length, width, height 

iv. Select Edit Mash from the modifier list  

v. Select polygon and apply  

 

FAQ-13  What is the function of “Extrude” command in 3D max? 

Answer:   the function of “extrude” command is to give height to the model.  

 

FAQ-14     How to import 2D AutoCAD Drawing into 3D Max? 

Answer:  

vi. Open 3D Max software 

vii. Click on the Quick access tool bar  

viii. Select the import option from Quick access tool bar  

 

FAQ-15  What are the contents in Manu bar in max. 

Answer:  It contains tools, edit, groups, view, create, modifier, animation, group editors, rendering civil view, 

customize, scripting and help. 

 

FAQ-16  Where is found “edit mesh” modifier? 

Answer:  In modifier list 

 

FAQ-17      Where is found “bevel” modifier? 

Answer:   In modifier list 

 

FAQ-18  What is vertex? 

Answer:   Vertex are the points in space which define the structure of face.                         

 

FAQ-19      How many Options in Editable Mesh? 

Answer:    There are following options in” Edit Mesh” vertex, edge, face, polygon and element. 

 

FAQ-20  what is face? 

Answer:  A face is the smallest possible mesh object  

 
FAQ-21  What is the “compact material editor”? 

Answer:  The Compact Material Editor is a material editor interface that uses a smaller dialog than the Slate 

Material Editor. 

FAQ-22  Name two type of material editor which are mostly used in Max. 

Answer:  1. Compact Material Editor       2. Slate Material Editors 
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FAQ-23  What is the function of “Material Editor”? 

Answer:  The Material Editor provides functions to create and edit materials and maps. 

FAQ-24  How many interfaces of Material Editor? 

Answer:  There are two interfaces of material editor Compact Material Editor: 

FAQ-25  What is “Material explorer”? 

Answer:  The Material Explorer lets you browse and manage all the materials in a scene. 

FAQ-26  what is meant by Texture? 

Answer:  The visual and especially tactile quality of a surface. 

FAQ-27  What you understand by “Edit of material”? 

Answer:  To review or edit the assets and properties of a material. 

FAQ-28  what is the function of “Height Manipulator” ? 

Answer:  Height manipulator is used to adjust the Height of model. 

FAQ-29  What are the uses of “Tile map”? 

Answer:  “Tile maps” are used for brick on wall and tiles on floor. 

FAQ-30  what is the function of “Flip “tool? 

Answer:  Reverses the image about the given axis. 

 

FAQ-31  what is the function of camera? 

Answer: camera present a scene from a particular point of view. 

 

FAQ-32      what is “target distance”? 

Answer:      it is the distance between the camera and object.  

                         

FAQ-33        How many types of Distortion? 

Answer:        There are four distortions named quadratic, cubic, lens life and texture.  

 

FAQ-34      How many types of camera view? 

Answer:   There are two types of camera view., 

a. Man, Eye View    
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(b) Bird Eye View 

   FAQ-35      How many types of lights? 

Answer: Types of lights are Photometric light, standard lights, Area lights, and V-Ray light 

. 

FAQ-36 How many types of V-Ray lights? 

Answer: Types of V-Ray lights are plane, disc, dome, sphere and mesh. 

 

FAQ-37 What is Mesh light? 

Answer: A mesh light creates a light source from an object’ surface area.  

 

FAQ-38 How many techniques for applying rendering? 

Answer: There are three techniques for applying rendering namely v-ray, corona and scanline. 

 

FAQ-39 why global switches are used? 

Answer: The global switches are used to control lights, shadows, reflections and map etc. 

 

FAQ-40 Why environment is used? 

Answer: Environment is used to create sky in render. 
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Test Yourself 

 

 

Multiple Choice Questions (MCQs) 

 

1) The short key of Undo is 

(a) ctrl + Z     (b) ctrl + N 

(b) ctrl + Y     (d)  ctrl + U 

 

2)  The symbol of 

(a) Select and Link    (b) Select object 

(b) Select and Move   (d)  Select and Rotate 

 

3) Ribbon tool bar have the option  

(a) 3 option     (b)  5 option 

(b) 7 option     (d)  10 option 

 

4) The short key of the Material is  

(a) M     (b)  MT 

(b) MA     (d)  M Enter 

 

5) Select the Select Object icon  

(a)      (b)  

(b)      (d)   

 

6)  The icon of  

 

(a) Create Panel     (b) Modify Panel 

  (c) Hierarchy Panel    (d) Motion Panel 

 

7) Position, Rotation and Scale are the option of  

  (a) Main tool Bar    (b) Transforms  

  (c) Light view Port     (d) Display Panel  
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8) Work through is the option of  

  (a) Light view Port     (b) Pan View 

  (c) Camera view Port   (d) Trak View 

 

9) The short key of Rotate is  

(a) RT     (b) RO 

(c) R Enter     (d) E 

 

10) Move short key is 

(a) M Enter     (b) W 

(c) MO     (d) MV 

 

 

11) Vertex is the option of. 

(a) Stat control    (b) Edit mash 

(c) Modify     (d) modifier 

12) Vertex is the option of. 

(a)  Stat control     (b) Modify Zoom  

(c) Edit mash     (d) modifier    

13)   The symbol of.  

(a) Face      (b) Vertex 

(c) polygon                                         (d) none of these 

 

14) The total no of Modifier button options is. 

(a) 25     (b) 30 

(c) 32                   (d) 35 

 

15) Cylinder command is used to Draw. 

(a) polygon     (b) 2-point circle 

(c) die      (d) Rectangle 

16) Edit Mash select from. 

(a) Quick Access Tool Bar   (b) Common panel 

(c) modifier list                  (d) with stack control 

17) In 3D max, set segments according to 

(a) length, width    (b) width and Height  

(c) Height and width                                  (d) length, width, Height 

18) they are the points in space which define the structure. 

(a) Vertices    (b) X-Axis 

(c) Y-Axis     (d) None of These 
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19) A face has minimum edges. 

(a) 3     (b) 4 

(c) 2     (d) none of them 

20) A face has minimum vertices. 

(a)       2     (b) 3 

(c)        4     (d)      none of them  

 

 
21) The material editor provides the function to “create and edit.” 

(a) Shapes     (b) Edit color 

(c) Create     (d) Material and maps 

22)   The Symbol of.  

(a)       Circle      (b) Sphere   

(c)  Material Brower    (d) Motion 

23) For Applying Material, the short key is. 

(a)  M + enter    (b) MT+ enter 

(c) m     (d) MR +enter 

24) We Apply Extrude command to. 

(a) Extrude     (b) delete 

(c) m     (d) Bevel 

25) Navigation is option of the Dialog Box. 

(a) Bit map     (b) Martial Editor 

(c) Map Browser    (d) Get Material 

26) Bitmap Apply For. 

(a) Delete Material    (b) Import Texture 

(c) Export Object    (d) Edit Color 

27) In 3D studio Max U,V,W cordites match for the 3D space. 

(a) Z,Y,X     (b) Z,X,Y Z 

(c) Y,X,Z     (d) X,Y,Z 

28) How many interfaces to “material editor” in 3D Max? 

(a) 2     (b) 4 

(c 6     (d) None of these 

29) The material editor interface which uses smaller dialog.                    

(a) Compact Material Editor   (b) Slate Material Editor 

(c) Interface    (d) None of Them 

30) Material editor is used for? 
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(a) Apply Material to Object.  (b) For Edit Material 

(c) Create Material    (d) All of these 

 

31) Sun light create.     

(a) Shadow    (b) Darkness. 

(c) Operate    (d) None of these 

 

32) Global illumination option has windows.   

                 (a) 3          (b) 5 

       (c) 4     (d) None of these 

 

33) Render set up have window. 

(a) 5     (b) 6 

                   (c) 3(d)     (d) All of these 

 

34) we control Resolution from in Render set up. 

(a) V-Ray     (b) Render Element 

(c) GI                       (d) Common 

      

35) work of image sampler on Render set up.              

          (a) save file         (b) Filter color 

         (c) control noise                      (d) None of These 

 

36) What is the work of Frame busses in Render set up? 

               (a) Image Quality    (b) Control light 

         (c) save path    (d) None of These 

 

37) How much plug-in use for Rendering?  

(a) 3     (b) 5    

(c) 4     (d) None of These 

38) Where is mention of memory of computer. 

(a) V- Ray     (b) setting 

(c) GI     (d) none of these 

 

39) A complete installation of V-Ray 3.6 max consists of. 

(a) 6     (b) 8 

(c) 7     (d) None of these 

 

40) Camera select form command. 

(a) create     (b) motion   

(c) modifier     (d) None of these 
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Answer Key 

1. A 2. D 3. B 4. A 5. A 

6. A 7. B 8. C 9. D 10 B 

11. B 12. C 13. A 14. C 15. C 

16. C 17. D 18. A 19. A 20. B 

21. D 22. C 23. C 24. A 25. B 

26. B 27. D 28. A 29. A 30. D 

31. A 32. C 33. B 34. D 35. B 

36. C 37. B 38. B 39. C 40. A 

 

 

 

 

 






